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BDS In Use 

Assumptions 

Once you familiarized yourself with the Blu-disc Studio capabilities, 
you set your imagination at work to create the blu-ray disc that does 
exactly what you intended it to do. 

Sometimes work of others inspire you to do something similar. 
Discover combinations available in BDS you had not realized. 

This guide walks through some of the examples to show the potential 
of BDS. It contains a number of the “live” examples shown on the BDS 
website at the time of writing. The examples mimic the behaviour of 
some commercial blu-ray discs to demonstrate that with BDS you can 
achieve the same results. The real discs have not been authored by 
BDS (except “Bravo” and “Brest Fortress”). 

This guide assumes you’re familiar with BDS features. It’s like a talk 
between doctors. They know what they mean while to outsiders it may 
be complete gobbledygook (jargon). This guide assumes you know 
what (object) “animation” means, what (button) “current state” 
means. So we can focus on the specific use of some BDS features that 
result in these live projects and resulting blu-ray discs. If you are 
unfamiliar with BDS, read its user’s guide first. And practice! 

For this reason, each chapter is dedicated to one of these live projects, 
and opens with a “Final Result” section, that lists a maximum of three 
available sources for you to watch or peruse. Not always all three will 
be available. 

• Movie showing the resulting menu in action: nothing better 
than to see the product in final state (though without the 
actual movies). This shows you how menus are connected and 
what button actions result into. It may inspire you on how to 
do such a thing yourself. 

• Sources in BDS project folder: a ZIP file with all the menus, 
movie objects and playlists that together make up the project 
(apart from the actual movies). Ideal for browsing and trying 
to follow the flow of events: button actions, animations, menu 
parts. It may fill the gaps in your inspiration after seeing the 
final result in action. 

• Movie instructing how to create the project: sometimes there 
is a YouTube or Blu-ray disc website movie that (with or 
without words) shows how to build the project. Together with 
the previous two resources, it shows how to use the project 
objects and what final result they will give to the viewer. 

Disclaimer 

The projects you can inspected do not always completely sync with the 
movies that show the final product. Apparently, some last minute 
changes were made that can be seen in the movies but not in the 
projects. 
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Where possible, I’ve used the projects as leading guide as that is most 
in line with what you can inspect yourself. 

Create your own project 

The projects that can be downloaded from the BDS website only 
contain the project files. These are XML formatted files that contain 
everything in terms of menus, animations, buttons and what you need 
to build a blu-ray disc. It contains all except the source files. No .png 
files for menus or button states, no actual movies. So you cannot run 
any of the projects to create a disc and see how it works in real life. 
Obviously, the movies cannot be included for copyright reasons.  

So what can you do? 

• Run the simulation. Use the End button to bypass any 
introduction movie if there is any and you need to go to the 
main menu. Use the F5 button to open the popup menu while 
a movie supposedly plays. And use F1-F4 to simulate 
behaviour of the coloured buttons on the remote control. 
This way you can see the disc in action – if not with actual 
movies 

• If you think you need movies: use some short ones of your 
own and modify the “movies” section of the project to let 
every movie object point to one of the movies of your own. 
Then build the disc and play it. The “Behind the Scenes” bonus 
movie may show Auntie Judy’s birthday party but the button 
to start it, works, the animation works. 
When chapters are involved, you may need to regenerate the 
scene images. They won’t be the same as what is used in the 
project’s scenes menus. But who cares? 

And feel free to experiment: adjust code, change actions. You can 
always re-download the original version of the project (or keep it in 
backup). Repeatedly I felt I could improve/change the project to do the 
same but with different (in my eyes more efficient) code.  

Playing with the projects can give you new ideas, the same ideas but 
handled differently, discovering “dead wood” that seems to do 
nothing but the creator never noticed.  

In any case, looking through these projects will give you a new feeling 
of what BDS is capable of. And that’s the point of the examples. No 
better flattery than imitation! 

What to look for 

Browsing through the projects gives you all sorts of ideas. Look at the 
“Interesting bits” sections of each project to see what interesting stuff 
it contains that you may want to replicate.  

Some projects have similar features. Sometimes they are described in 
both, sometimes one project refers back to the other. It all depends on 
when the chapter was written. 
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Force of Execution 
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The final product 
Movie showing the resulting menu in action: 

Sources in BDS project folder: 

Movie instructing how to create the project:  
BDS1 https://youtu.be/nRwpKTNSlJ4  (basic setup) 
BDS2 https://youtu.be/qW_DHs1nKOo (carousel chapter menu) 

Story 

A crime boss sends his top man to kill a prisoner. He gets the wrong 
man and pays the price. 6 months later he's back on his feet. His ex 
boss is now being squeezed out by Ice Man, who's responsible for the 
"wrong man" deal. 

99 min, 2013, Kuwait, director: Keoni Waxman 

Overview 

“The Force of Execution” has a main menu that calls additional menus. 
All menus are stacked on top of each other – causing the previous 
menu to remain visible – as picture images only. 

The movie also has its popup menu. This is very similar to the main 
menu, but where the “main menu” has an option to “play movie”, the 
popup menu replaces this by “go to main menu”. 

The movie has a two chapter menu’s, each showing six of the twelve 
chapters. Moving from the menu with chapters 1-6 to the menu with 
chapters 7-12 occurs through an animation where the old six chapter 
images slide out of sight to make room for the new chapter images.  

Interesting bits 

This project has many standard elements to build menus. The part that 
makes it special, is the way it treats the chapter menus. The BDS 
generated menus provide separate menus for a series of chapters. The 
transition between those chapter menus is instantaneous. Either you 
see a menu with chapters 1-6 or the menu with chapters 7-12.  

Force of Execution animates the change between the chapters by 
sliding away the old set of chapter images to reveal the new set. This 
treatment is called “carousel menu”. Another way to handle a carousel 
is by changing chapter images individually. That is shown in the project 
“The King’s Speech”. 

 

https://youtu.be/nRwpKTNSlJ4
https://youtu.be/qW_DHs1nKOo
https://www.imdb.com/name/nm0915394/?ref_=tt_ov_dr
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Ordinary menus 

Basic setup 

The “Force of Execution” has a menu setup that consists of rectangular 
blocks at the bottom. The movie itself has similar popup menus. 

Main menu 

Looking at the main menu: 

• The main menu at the lowest level. It has 4 textual buttons 
that result in (from left to right – in Russian): 

o The movie starts playing 
o The main setup menu is shown on top of main menu 
o The main chapter menu is shown on top of main menu 
o The main extras menu is shown on top of main menu 

 

• The setup menu – if the 2nd button is activated, the setup 
menu has an extra rectangular block on top of the main menu. 
The bottom row has become a set of pictures where the 
“Setup” remains in its “selected” picture state. 
The top row has two buttons (from left to right): 

o Audio 
o Subtitles 

 
 

• Each of the buttons opens yet another level of menus on top 
of the existing two. These former two become pictures again. 
When the “Audio” is selected, two buttons allow to select 

o Russian in Dolby Digital 5.1 
o English in Dolby Digital; 5.1 

 

 
 

Unique here is that each button also has a “Current” state 
image (in the form of a cross wire) to indicate the current 
setting. It will change (highlight) if another selection is made. 
 

 
 
The “Press Enter” is a multi action 
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o It sets of the chosen audio track (above shown: 

English) 
o It closes the menu and re-opens the main setup menu 

(only 2 rectangular menus remain, the top one with 
buttons) 

 

• When “Subtitles” is selected, another menu opens. The 
bottom two layers become picture again, only the top contains 
three buttons: 

o English 
o Spanish 
o None 

 
 

Unique here is that each button also has a “Current” state 
image (in the form of a cross wire) to indicate the current 
setting. It will change if another selection is made. When 
English is selected, the “Highlight” will change the button to 
“Current” accordingly. 

 
It also performs a multi-action to set the subtitle to the chosen 
titles and closes the “main sub” menu to return to the “main 
setup” that becomes active again. 

 
 

• When “Chapters” is selected, the first of a set of chapter menus 
is opened. 
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These chapter menus are partly generated, partly hand-made 
and will be discussed later (as carousel menu). The arrows at 
both ends connect the various chapter menus for “previous 
chapters” and “next chapters”. As we will see later, they actually 
are not buttons. For the left most chapter the events are shown 
below. Note that “press left” opens another chapter menu (P 1 
1) and in doing so, acts as if the arrow button was selected. 
 

 
 
When the down arrow is pressed, the chapter menu disappears 
and the setup menu re-appears. If a chapter is selected, the 
movie is started at that chapter (For the image at chapter 1 this 
is Movie[1]). 
 

• When “Extras” is selected, another menu Extras is opened, 
containing a single choice. 

 

When that choice is made, the “Extras” movie starts playing 
from chapter 1.  

Main menu: opening animation 

To make the menus a bit livelier, all of them contain animation of a 
simple kind: fade in or fade out. 

The main menu fades in with all its elements. Therefore, there is no 
need to specify animation groups: 

 

This Enter property is the result of the “Animation” action for the 
animation property. 

Because two (short) credit movies are shown when the disc is inserted, 
the menu appears at the end of the second movie. The End Action of 
that movie opens the main menu: 
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It doesn’t just open it; it specifies to open it by running its animation 
first and then continue with action 1 (if there is one). 

The animation of the menu itself is specified in the animation window: 
a fade in of all objects within 5 frames (at 24 fps this has a duration of 
5/24th second). 

 

Other menus: opening animation 

The animation of all other sub-menus opened through the main menu 
are similar to the main menu, except for a big difference. All objects of 
the menu that opened the next level menu have been converted to 
pictures. They are already on screen and need not re-appear by a fade 
in. Only the “new” appearing objects of the new menu fade in. 

That means that those and only those objects are grouped into an 
animation group and only that group is animated to fade in. If we take 
the “Setup menu” it has pictures of the “main menu” objects. Those 
should not be animated.  
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But both its buttons (Audio, Subtitle) as well as its rectangular 
background (BG2) must fade in. They are grouped in “anim group 1”. 

Then the ENTER action is an animation to fade in all objects of 
animation group 1 taking 5 frames (5/24th second). 

 

The corresponding animation window is filled in as shown below. 

 

All other submenus (main audio, main sub and chapters) also fade in in 
a similar way. 

Chapter menu: special opening animation 

The chapters menu is an odd one. There are 12 chapters, divided over 
two chapters menus (1-6, 7-12).  
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When the “Setup menu” activates the “chapters” button, it invokes 
the menu “main scenes 1 1”. This is a duplicate of “main scenes 1” but 
consists solely of pictures. 

 

These pictures are chapter images (named “number”) and chapter 
numbers (below the chapter image, named “Nnumber”). They are new 
and must fade in. But there are also pictures of the objects from the 
main menu and setup menu. They already exist and do not fade in. 
Hence again an animation group 1 is made for all new objects that 
need to fade in. 

 

But as soon as the entire picture-based “main scenes 1 1” menu has 
faded in, it transfers control (via Action 1) to the real “main scenes 1” 
that has all chapters as buttons to select. It opens with chapter button 
named “01” as button-selected-by-default. 

 

All menus: closing animation 

When the viewer has made a choice in one of the top menus (audio, 
subtitle or chapter) the menu closes as part of the “On ENTER” action. 
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It also closes if no choice is made, but instead the down arrow is 
pressed. 

If a choice is made, first a (multi) action is performed to set the audio 
or subtitle.  

The next action is to relegate control to another menu. This happens in 
both cases: 

• A choice was made 

• The down arrow is pressed 

The disappearance trick of the current menu is animated. After the 
end of the animation, the other menu is opened and gets control. 

In both the “Press ENTER” (when a choice is made) and “Press Down” 
animation the fadeout is specified. As an example, for the button that 
sets a subtitle to the 2nd track and returns to the setup menu, the 
specified action and animation are shown below. 

 

You may wonder why not all objects of the menu fades out and why 
only the animation group is specified.  

When you try to fade out the entire menu, you will see that the 
pictures of the lower level menus would also fade out. Once gone, 
they pop back again when the other menu is opened. They are objects 
on that menu too and hence “suddenly” reappear. Not fading them in 
the closing menu avoids this. 

For the chapter menu the working is slightly different again: if a 
chapter is selected (example below uses chapter 8), the movie plays 
from that chapter onwards. If the down arrow closes the chapter 
menu, an animation occurs after which the main menu is shown. 
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Popup menus 
While the movie plays, a popup menu can be opened. And from that 
popup menu, additional menus can be opened.  

Often, they look remarkably like the ordinary menus. Except the “play 
movie” on the main menu is replaced by “main menu” on the movie 
popup. But the rest is often the same: change the audio or subtitles of 
the movie or show its chapter menu. 

Compare the main menu: 

 

With its popup menu equivalent: 

 

The popup lacks the “extras” menu item (far right) and replaced “play 
movie” with “main menu” (first left). 

The “chapter menus” to show from the popup menu are identical to 
the ones seen in the main menu.  

BDS makes it easy to copy those menus from the “Menus” into the 
“Popup menus” section of the Project Tree view. Just select any menu, 
right mouse click and select “Clone between main/popup”.  

Note: BDS provides cloning between menus and popup menus but not 
the other way around. Therefore, always start with creating chapter 
menus in the menus section. Then clone them to the popup menus 
section. 

There is also a “Clone all between main/popup”. That choice might 
clone more menus than you want. However, the ones you don’t need 
are easily deleted after cloning. It may work faster than cloning menu 
by menu. 

 

For this reason, we won’t spend much time on popup menus. See the 
regular menus for similar setup of actions and animations. 
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Chapter menus: carousel 

BDS provides a generated manner for creating chapter images and 
chapter popup-menus. 

In fact, this generation does what you otherwise do by hand. The latter 
method takes more time but is also more flexible. You can determine 
yourself how the chapter popup menu should look and how it should 
respond. 

The generated chapter menus have a “<” previous and “>” next button 
to move through the next set of chapter images. 

A carousel is an endless loop of chapter images. When you reach the 
end of a sequence of chapters, the menu is replaced by later chapters 
or earlier chapters. And if you want, the first chapter is positioned next 
to the last chapter. That way all chapters are connected in an endless 
loop. 

 

Create chapter images 
First let BDS create the chapter images. This can be done in two ways: 

• Images of the chapter of the movie 

• Images complete with frames defined in a preset 

Grab images 
Images of chapters can be grabbed manually or through the BDS 
generator. When you do it manually, you can take any scene from a 
chapter you see fit. Grabbing is done through any video editor or 
media player with capture capability (such as VLC).  

Generate images 
When you generate the images by BDS, they will be near the spot 
where you defined the start of the chapter. 

When you generate scenes, open the movie’s “Scenes” window where 
you defined the chapter marks. Then click on the “Generate Scenes” 
button. From the dropdown you either select “Generate scenes 
bitmaps” or “Generate scenes menus”. 
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If you take “Generate scenes bitmaps”, all chapter images are 
generated as lossless .bmp files in the project folder 
\Chaptersimages\Bitmaps. 

That is also the default suggested location if you take “Generate 
scenes menus” but here you can change it into something you like 
better (especially if you got several movies with chapters).  

 

 

The bitmaps are in the 16:9 aspect ratio of the blu-ray movie and also 
have the resolution of the movie (e.g. 1920x1080 pixels). And they are 
lossless – a good start for reducing them to smaller thumbnails in a 
lossless .png format to be used in a chapter ribbon. 

Create chapter scenes 
Once you got the chapter images, they need to be reduced in size to 
become a chapter image thumbnail in a chapter menu.  

Manually reduce images 
Any image editor is capable of reading in .bmp (or other format) 
images and reduce their size. Often a menu option to “Resize image” is 
available to do this (PhotoShop: Image > Resize Image).  

If you intend (as this project does) to use the images as (“normal”) 
button state images, you need to save the output as .png file because 
that is the only image format BDS will recognize. 

If the images themselves become part of a menu-strip with chapter 
pictures you may insert all the images and reduce their size within the 
image editor (like PhotoShop Edit > Transform > Scale). Position them 
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on a rectangular background and save the final composition as .png 
file. 

 

Here a PhotoShop option to draw “guidelines” may come in useful. To see 
them ensure View > Show > Guides is checked. Add a horizonal guide line 
by moving the mouse to the top of the image window, keep left mouse 
pressed and drag a blue line down to where you want it. Same from the 
left side to drag in a vertical line. Repeat for as many lines you want. 
These lines won’t print and do not show up on “Save As” image files. But 
they provide a frame within which you consistently can move layer 
objects so they fit. You can also use View > New Guide to create a 
horizontal or vertical guide. View > Lock guides or Clear Guides fixate or 
remove the guides. If you need to know the exact position of a guide line, 
open the Info panel (Windows > Info) and position your mouse on the 
guide line. The info panel gives the X,Y coordinates of the mouse. 

The guides can also be used when you compose menu objects and want 
to stay within “safe areas” of the television screen. 

Generate reduced images by BDS 
You can also create reduced images through BDS. It is part of the 
automated sequence to generate an entire chapter menu. For 
reduction, we only use the second part of the generation. This does 
require the chapter images have been generated earlier. If not, you 
must execute two steps in the generation process: generate bitmaps 
and (from them) generate chapter images. 

 

In the generation process you specify the folder in which the .bmp 
bitmap images are stored as well as the preset by which those bitmaps 
are converted into chapter images. The “blue” preset that comes with 
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BDS creates images with blue frames. The “selected” chapter gets a 
white frame.  

 

At completion, the (default) project folder \Chapterimages\scenes 
then contains .png files with the generated bitmaps complete with 
previous/next button images, and frames and chapter numbers. 

 

The aspect ratio is again 16:9 (as should the preset frames be) but the 
size of the .png image is a lot smaller: the size defined for the 
thumbnail (273x151 pixels) in the preset data.ini file. 

 

In the main folder \ChapterImages you will then also find the button 
images for previous/next as well as the different frame rendering for 
selected (white frame instead of blue – when a chapter is selected the 
“selected” state white frame is shown on top of (and covers) the 
normal blue frame). 

The current state of the button is also defined (a “check” in preset 
“blue”). 

If you want a different rendering of the generated chapter images, you 
need to define your own preset collection. 

Create chapter menus 
Generate menus through BDS 
If you go for the full treatment of BDS chapter menu generation, you 
need to also check the “Generate menus” checkbox. 
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Then let BDS go the entire way: making chapter bitmaps, chapter 
images and chapter menus (that show parent graphics as pictures 
rather than buttons). Transitions between chapters menus is 
instantaneously: chapters 1-8 are shown and moving from 8 to 9 
suddenly shows the chapters menu of chapters 9-16. There is no 
gradual change between menus. 

This is not the way “Force of Execution” has its chapters menus set up. 
Transition between them has an animation of sliding away of the old 
chapters menu to make way for the next one. 

Create chapter menus manually 
For ultimate control over how a chapter menu should look like and 
how it responds to viewer actions, you need to setup the menu 
yourself. Bitmaps and chapter images may have been made yourself or 
generated by BDS. The final step, creating chapter menus, is done 
manually. 

Use those .bmp or .png bitmap or scenes images to construct your 
own chapter menu by combining several images into a single chapter 
menu. 

• Use a rectangular background on which the chapter images 
are shown. This rectangle is likely also the size of the chapter 
popup menu 

• Add a button at each end to indicate “previous chapters” and 
“next chapters” where applicable. Usually this is some sort of 
arrow. 

• Add the chapter images. Either as image or as “normal” state 
of the chapter button.  

• Add buttons to each chapter. Its “selected” state image should 
somehow visually highlight the chapter (the normal state can 
be absent or transparent. Or, the image itself may be the 
normal state). 

If you have used a scene preset it makes life easier: the .png files 
already have the right “normal” border. And the “selected” border can 
be copied as additional layer into the ribbon PhotoShop file. 

In the case of this project, it was decided to make the chapter button’s 
“normal” state identical to the plain chapter image. 
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The “selected” state button is taken as a simple rectangular frame that 
surrounds the chapter images. 

 

We start with creating menus for six chapter images: six buttons with 
their normal and selected states that overlap. The previous/next 
arrows are simple pictures.  

The chapter images are the “normal” state of the buttons for chapters 
1-6 or 7-12. The chapter numbers beneath the chapter images are 
plain text and provided only for viewer reference. 

 

 

On top of the images, their rectangular “selected” state button is 
positioned. 

 

 

When used, only one “selected” frame is shown. They are connected 
to each other for navigation. As such, the “Press Left”, “Press Right” 
and “Press ENTER” actions for chapter 9 move the selected chapter to 
8 or 10 respectively. And when OK is pressed, chapter 9 starts playing. 
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In line with the discussion on animation of menus, the “Press Down” 
action returns to the main menu but fades out animation group 1 
(which contains all of the chapter-bar images on top). 

It becomes interesting to see what is specified for the outermost 
chapters as they will replace the current chapter menu (7-12) with the 
previous one (1-6). Chapter 12 will move on to chapter 1 and vice 
versa. The actions for button “12” for chapter 12 are shown below. 

 

The “Press Down” action and animation are no different. Nor is “Press 
ENTER” to start the movie at chapter 12 or “Press Left” that moves to 
the previous chapter button, chapter 11. 

Moving to the right (effectively to chapter 1) is different though: 
another menu P2 is started and its opening animation must be shown. 
This has all to do with the “chapter ribbon”, discussed below. 

If you want to keep it simple, you swap the chapter 7-12 menu for the 
1-6 menu (selecting chapter 1) and take it from there.  

 

Ditto for the chapter 7 button that on left move also displays the 
chapter 1-6 menu (selecting chapter 6). 

The change is abrupt: no animation. Just the way BDS chapter menu 
generation would do it. 

Create a menu ribbon 
“Force of Execution” makes the switch between menu chapters more 
fluent. If either end of the current chapter menu is reached, the entire 
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chapter menu slides to the left or right (depending on which end of the 
chapter menu you are) to make way for the other chapter menu. 

So how is this achieved? It’s all done with smoke and mirrors. 

In-between menus 
The mirrors are in-between menus with pictures only. The smoke is 
the animation of those menus until the active new chapter menu is 
ready. With the clever use of the animation “clipping area” property. 

What happens if chapter 12 is currently selected and we press the 
right arrow button to move to the next (i.e. chapter 1) chapter on 
another chapter menu. 

 

The “Press Right” action does not invoke the right arrow (although the 
viewer may think so), it simply starts a new menu, P2, introduced with 
its animation. 

Menu P2 consists entirely of pictures. All chapter pictures belong to an 
animation group 1, the rest (the bottom part with Main Menu objects 
but also the grey background) do not. With reason: that part of the 
menu is also present in the new final chapter menu that is shown 
when we’re done. So, let’s not confuse the viewer (it hasn’t confused 
the Russian author!). 

 

Slide animation 
The animation of group 1 is to slide in 22/24th second from where they 
are (the leftmost top is positioned (relatively) at (left,top)=0,0) to their 
final position, -1536 pixels to the left. The animation looks like the 
chapters slide off to the left beyond the left margin. They do not move 
vertically (top remains 0). They do move horizontally (left =0 becomes 
left = -1536). 
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There is also a clipping area. This specifies what area on screen is 
affected by the animation. Any animation that goes outside the area is 
clipped: it doesn’t show. The borders of the clipping area indicate the 
first row or column of pixels that are visible. 

Consider it a mask with a hole in it (the clipping area). You only see 
what happens inside the hole – anything beyond remains untouched. 
When the clipping restricts itself to only horizontal positions while 
covering the entire height of the screen, the clipping area can also be 
seen as a stage with curtains on both sides: you cannot see what 
happens behind the curtains. Only the stage (clipping area) is visible. 

The clipping specifies that anything between 0-196 pixels from the left 
edge is not affected by the animation. Anything moving to the left 
from position left=197 pixels to left=196 simply disappears from 
screen.  

It also specifies that the same happens for anything between pixel 
position left=1724 to left=1919 pixels (the right edge of the screen). 
With the intended sliding to the left suddenly objects may become 
visible when they move to the left from position left=1724 (invisible) 
to left=1723 (visible). 

The vertical area is not affected: any animated menu object between 
height top=0 pixels (top row) to bottom=1080 pixels (bottom=1079 is 
the last row of pixels at the bottom of the screen, so the area suggests 
one line below screen is visible as far as the BDS application is 
concerned) is unclipped. 

Sliding both ways 
We looked at sliding to the left when the viewer goes the right. It can 
also go the other way of course. In that case the viewer goes to the 
left, meaning the animation must go to the right.  

The animation to the right is the opposite of the animation to the left. 
From relative position (0,0) you now slide to (0,1536) and chapter 
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images disappears at the right edge of the clipping area and appear at 
the left edge. 

 

The numbers behind the animation 
Where do the specified numbers (all in pixel units) for the animation 
come from? 

 

• Clipping area: 197 < left < 1723  
The first chapter image is positioned at left=197. The final 
chapter image at left=1477. The width of the image is 246. 
Therefore, its right edge is at 1477+246=1722. The width of 
the clipping area is 1723-197=1526. The sizing info can be 
obtained from the image object properties window. 

• Slide from relative (left,top) = (0,0) to (-1536,0) 
The top left of the first chapter image is positioned at (0,0) if 
all measurements are taken relative to this animation group 
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initial position. Sliding to -1536 means the entire group moves 
and chapter image 1 ends up at (left,top) = (-1536,0), i.e. 1536 
pixels to the left of its present position. 
The chapter images shown fit inside the clipping area (width 
1526). But each image is separated by 10 pixels. So is the last 
image. If we are to move the chapter images in such a way 
that the new first chapter image is at the left clipping edge, we 
must slide the width of the chapter images plus the final 
separator. That makes it a sliding over 1526+10=1536 pixels. 
And sliding to the left this becomes –1536. 

The sliding menu 
The sliding menus consist entirely of pictures as it is some “in 
between” menu used for animation, but should disappear after the 
effects to make room for the real new chapter menu.  

If chapters 1-6 are displayed and 7-12 are needed, the sliding menu 
animation must start with showing chapters 1-6 and then slide to 
reveal 7-12. When those are in position, the sliding menu disappears 
and opens the real chapter menu with chapter buttons for 7-12. 

This is also true the other way around (7-12 are on display, but 1-6 are 
needed). And in both cases we can move the cursor to the left 
(meaning sliding to the right) or to the right (sliding to the left). 

All in all, 4 sliding menus are needed to cover all eventualities in 
selecting a chapter to allow continuous circular movement: 

1. From 1-6 to the menu 7-12 if you transition from 6 → 7 (slide 
to left) 

2. From 7-12 to menu 1-6 if you transition from 12→ 1 (slide to 
left) 

3. From 1-6 to the menu 7-12 if you transition from 1 → 12 (slide 
to right) 

4. From 1-6 to menu 7-12 if you transition from 7 → 6 (slide to 
right) 

(In fact, there are only 2 sliding menus and 2 personalised copies: a 
left-sliding and right-sliding menu. The left-sliding menu 1-6 → 7-12 is 
cloned and personalized for the left-sliding menu 7-12 → 1-6, only 
their default selected chapter is different at either end of the sliding 
result). 

These situations are illustrated below. The grey areas are beyond the 
clipping area and anything positioned there is invisible during 
animation. 
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From 6 to 7 
Let’s first assume the first six chapters are shown in the “main scenes 
1” menu. They can be selected. But if the viewer is on chapter 6 and 
presses “Move Right”. This means the second chapter menu “main 
scenes 2” must be shown and chapter 7 becomes the selected one. In 
between the animation suggests that chapters 1-6 slide away to make 
room for 7-12.  

To achieve this, the “Move Right” action for chapter 6 in menu “main 
scenes 1” opens (animation) menu “P1”.  

 

This menu performs its animation. And by lack of any buttons, it 
performs its action 1 that opens the real “main scenes 2” menu at 
chapter 7. As final position of the sliding is exactly how “main scenes 
2” menu looks like, the transition to that menu happens seamlessly. 

 

The animation is specified in the animation window. It only moves the 
chapter images (collected in animation group 1), none of the others. 
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From 1 to 12 
From the same “main scenes 1” chapter menu, pressing “move left” if 
currently chapter 1 is selected, forces us to slide the 1-6 chapters to 
the right and replace them again with 7-12 of “main scenes 2” menu. 

This time the button for chapter 1 has a “Move Left” action that 
triggers the animated sliding menu “P1 1”. 

 

This animation of this menu is sliding to the right but again it stops in 
such way that when it ends and opens the “main scenes 2” menu, the 
transfer is seamless and the selected chapter is 12. 

 

Because the sliding is to the right, the initial position (left,top)=(0,0) 
now becomes ( +1536,0). 

 

From 6 to 5 and 12 to 1 
Without further comments, we’ll show how the other two animation 
menus work to move from a chapter menu for chapters 7-12 back to 
the menu for chapters 1-6, both then we make the change from 6 to 5 
or from 12 to 1. 
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I’m sure that will keep you busy for a while.  

Multiple chapter menus 
Imagine if you have 3 or 4 chapter menus and you want to give it he 
carousel treatment. Each transition between 2 menus requires 4 
sliding menus if done the way described above. For 4 chapter menus 
you’re looking at 4x4=16 sliding menus.  

You can get away with only two sliding menus: one to the left and one 
to the right. Then clone as many left or right sliding menus as needed 
to cover the entire range of chapters.  

It also helps to make every chapter menu use the same names for the 
buttons. If a menu has chapters 1-6, you might call them “btnChN1” to 
“btnChN6” where “N” reminds you that it is one of many chapter 
menus. The next chapter menu (7-12) also has buttons “btnChN1” to 
“btnChN6”. Keeping the names the same allows you to create switch 
actions referring to a specific button name even if they are on different 
menus. 

Cloning menus is done in the Project Tree view. Select a menu, hit right 
mouse button and select “Clone tree item” from the dropdown menu. 

If you use proper “neutral” naming conventions for the various menu 
objects of the sliding menu, this cloning technique may save yourself a 
lot of time. 

A cloned menu is an exact duplicate of the original menu including all 
its animations.  

For example, the two sliding menus can be generically named 

• Slide chapter menu to previous (=slide right) 

• Slide chapter menu to next (=slide left) 

Of course, afterwards you still need to “personalize” the cloned menu 
by giving it a proper name and by replacing the sliding chapter images 
by the proper sliding chapter images. One set could be renamed into 

• Slide chapter 1-6 to previous 31-36 

• Slide chapter 1-6 to next 7-12 
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On no account delete the sliding chapter image object and recreate it 
(by the same name). Deleting an object also deletes any animation 
that refers to it. Keep the object, just replace its picture image. 

When you use an image editor such as PhotoShop to create these chapter 
image layers as picture objects, it can be helpful to rename these layers to 
reflect chapter numbers rather than the default PhotoShop naming. 
Increasingly, little add-ins written in JavaScript (but also AppleScript on 
Mac and VBScript on Windows, JavaScript works on both platforms) are 
written that can take a lot of tedious work out of your hands. There are 
various “rename layers” scripts on the net. Add them to the 
\Adobe\Photoshop\Presets\Scripts folder and activate them with File > 
Scripts > Browse (if they do not show up by themselves). JavaScript files 
have the extention .js or .jsx 

 

The one thing that remains to do, is to ensure that on the newly 
displayed chapter menu, the right chapter image is selected as default. 
For example, if the first menu of 6 chapters (1-6) is moved from 
(selected) chapter 6 to the second menu of 6 chapters (7-12), the 
chapter 7 should become selected. And if chapter 1 was selected and 
moved to the last chapter menu (say 31-36), the new selected chapter 
should be 36. 

To accomplish this, you will need to use a Switch action. And if all 
chapter menus use the same names for the chapter buttons, the 
sliding menus can open the next chapter menu by action “open 
chapter menu X at default btnChN1” if the leftmost button for the 
leftmost chapter image should be used. 

Creating sliding menus: positioning out of sight objects 
The menus that provide the sliding animation can be quite wider than 
the width of the blu-ray menu screen (that has a maximum of 1920 
pixels). If the chapter images that are visible in a menu fill most of the 
screen, surely the ones preceding them or following them won’t fit on 
the screen, 

This is not a problem in animation. You can move entire menu objects 
out of sight by sliding them past the 1919 boundary at the right side 
edge of the screen or way before the 0 left edge. 

Therefore, you can create a menu with items that are initially 
positioned off screen. At the start of animation, the sliding menu P1 
has its position of Chapter 1 button at exactly the same location as the 
real chapter menu “main scenes 1”: (left,top) = (197,706). 

The chapter 12 (to the left of chapter 1, but only on the animation 
menu since it has to slide to the right) is invisibly positioned at 
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(left,top)=(–59,706). Chapter 11 is even further out of sight: (left,top) = 
(-315,706). And so on.  

Manually positioning within BDS  
When you import all chapter images one by one as a new object in the 
sliding menu, the positions can be entered in the object’s properties 
“top” and “left”. The top is always the same for all, the “left” 
increments or decrements with the width of a chapter image plus the 
separation between images. In the case of “Force of Execution” the 
width is 246 pixels, the separation 10 pixels, together 256 pixels. 
Therefore, if Chapter 1 image is positioned at (197, 706), the one to its 
left (Chapter 12) is at (197-256, 706) or (–59, 706). 

Manually positioning with an image editor 
If you use an image editor like PhotoShop, you enlarge your canvas to 
about 3 times the width of the HD screen (3 x 1920 pixels). The middle 
third of the canvas is then visible on screen (if clipping areas don’t 
further limit the range), the left and right thirds of the canvas are “off 
screen” at the left or right. 

Any image you load (into its own layer) is then carefully placed at the 
right position. For this to work comfortably, in PhotoShop you may 
want to 

• Set length units in pixels (instead of cm or inches) (Edit > 
Preferences > Units & Rulers) 

• Use guides to keep all images in a straight line (View > New 
guide or simply drag one from top or left margin with left 
mouse button). Use guides also to mark the middle part of the 
canvas that will be visible on screen (the middle 1920 pixels). 

• Open the View > Info pallet to display exactly the top left 
position of the image as well as its width. 

 

PhotoShop makes it easier to create the sliding menus from the two 
chapter menus: 

• Open a chapter menu file 

• Select all layers containing the chapter images (and their 
numbers) 
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• Copy those layers (Edit > Copy or CTRL/C) 

• Go to the sliding menu and paste the chapter images back 
(Edit > Paste, CTRL/V). The layers are a duplicate of the real 
menu: same images, same separation, same everything. 

• Because the pasted layers are still selected, you can move the 
entire set to its proper location. Use the info panel information 
to be sure. 

A word about the menu video 
The “Force of Execution” is shown as a long silent movie showing you 
how to create the carousel menu for chapters. The basic handling of 
the menus is similar to what is described in this chapter. 

However, the person authoring the movie also: 

• Renames PhotoShop layers for all “Slides NN” that are menu 
chapter images though an add-in Rename Layers tool script 

• Creates sliding menus with chapters at the left and right of the 
visible chapters. This way the menu could be easily duplicated 
and either shift 6 chapters to the left or to the right. This can 
save you some time compared to making menus (“P1” and 
“P2 1” are essentially the same, but start animation from 
different positions) 

The end result is the same however. 
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Big Buck Bunny 
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The final product 
• Movie showing the resulting menu in action: 

https://youtu.be/ffh-d-nFJGc  

• Sources in BDS project folder:  
https://blu-disc.net/download/examples/Big_Buck_Bunny.zip  

• Movie instructing how to create the project: n/a 

This project has also been discussed in the User’s Guide to BDS 
Standard and MX by the same author. The content of this chapter is 
more or less a copy of the text in that user’s guide. 

Story 

A recently awoken enormous and utterly adorable fluffy rabbit is 
heartlessly harassed by a flying squirrel's gang of rodents who are 
determined to squash his happiness. Animation. 

10 min, 2008, the Netherlands, director: Sacha Goedegebure 

Overview 

The disc starts with some animation while loading and after two short 
licensing movies the main menu is shown. It starts with running a 
background intro movie. Once this finishes the menu movie starts (and 
loops) and the menu choices and buttons are revealed. 

The main menu is the departure point to show other menus that keep 
the original main movie objects as picture objects only. 

Interesting bits 

This project is interesting for several reasons: 

• Its use of the intro movie in the main menu 

• The animation of menu objects 

• Use of identical menus except for one picture that “flags” 
whether a certain condition has been set 

• The use of picture-in-picture 

What makes this project stand out from other projects is its use of the 
picture-in-picture feature. To create this aspect of the project, BDS MX 
is required. All other parts can also be achieved by BDS Standard. 

https://youtu.be/ffh-d-nFJGc
https://blu-disc.net/download/examples/Big_Buck_Bunny.zip
https://www.imdb.com/name/nm3060230/?ref_=tt_ov_dr
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Ordinary menus 
 

 

Basic setup 

When the disc is inserted, it starts with a loading animation, as 
specified in Project Properties > Loading 

 

The .anim file contains a list of 8 .png images that are all shown in 
sequence. Each for the duration of 1 frame. It shows a flapping bird. 

 

Next, the First Play of the project indicates to run a movie called 
“license”. 

 

This short movie displays the (open common) license conditions. Its 
End Action chains to a short second movie, “Dynamic HD logo” that 
“brings high definition to the internet”. A bit like those “Dolby 
Surround” introduction movies.  

The HD logo movie ends by specifying that the main menu “menu” 
must be opened, starting with its animations. 

 

That menu is also started whenever the viewer presses the “Top 
Menu” button on his remote. 

(It’s not shown in the project, but both opening movies can have all 
remote control buttons disabled to avoid viewers to bypass the movies 
and go straight to the menu). 

Main menu  

The main menu is called “menu” and shows the basic choices that can 
be made. The menu consists of a picture with the bunny and some 
textual buttons: 

• Play movie (button “play”) 

• Extras (button “extras”) 
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• Commentaries (button “comment”) 

Before the picture and buttons are shown, the “menu” first plays its 
intro movie “intro”. It only has a begin and end chapter mark. The 
latter is the 2nd playmark and the point where the menu objects show 
themselves. 

The menu objects occur at the end of the intro movie – effectively at 
the start of the regular “menu movie”. The intro movie is 1:03 seconds 
in length – the regular background menu movie picks up the same 
movie starting at 1:03 and continues playing it. The transfer from intro 
movie to menu movie is seamless. 

The position of the “MainBG” background is at (left,top)=(0,400) on 
the BDS Designer screen.  

Animation is performed on all objects, including MainBG and they 
animate as one block. Animation start and endpoints are always given 
relative to the absolute position of the picture.  

 

When the animation is specified as starting from relative position 680, 
it means it is 680 pixels below the absolute position of MainBG. That 
means it starts from (400+680, 0+0) = (1280,0).  

The zero point for “top” is at the upper left corner of the screen, 
counting downwards is taken as positive direction.  

A positive value of 1080 therefore means that the MainBG rises 
upwards from just below screen to its final location (relative (0,0), 
hence absolute (400,0). 
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The animation type (“elastic”) indicates that rising up of the objects 
does a bit of bouncing before the position is taken in. 

 

 

 

 

The three text buttons not only have a “normal” state, but also a 
“selected” state. The same text is shown, but rendered slightly 
different (coloured blue). Both states are shown in the Designer 
window. 
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Play button 
The “play” button does what it is supposed to do: start playing the Big 
Buck Bunny movie from chapter 1 onwards. 

It does so after the animation defined for it. It reverses the animation 
when the menu opened. All menu objects move from current position 
to 680 pixels lower (remember: downwards is counting upwards). That 
means the entire menu drops out of sight at the bottom of the screen. 

 

 

Extras button 
The “Extras” button opens a new menu. It has all the objects of the 
main menu as pictures but add a billboard that slides in from the 
bottom. It contains the “Extras” menu buttons.  

The “extras” button executes a Switch action to check whether 
picture-in-picture (PIP) has been activated or not. When it is a different 
“extras” menu is opened (Extras PIP) than when it is not (Extras). Both 
menus are completely identical, except for a little butterfly that is 
coloured pink when PIP is on and grey when PIP is off. These are small 
picture elements called “Marker 1 on” and “Marker 1 off”. The two 
menus only difference is the use of either picture element. 
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It’s the only way BDS can signal a setting by some picture object. There 
is no way to instruct “colour object butterfly red” at run time – it must 
all be achieved through static elements in menus.  

When the “Extras” or “Extras PIP” menu is opened an animation 
occurs. 

The animation slides the billboard objects (collected in animation 
group 1) from the bottom. 

 

As it happens, the billboard is positioned at top=591 pixels – that 
means 1080 – 591 = 489 pixels to the bottom the screen – exactly its 
height.  

Relatively its top=0. The animation starts at relative top=591 (that is 
591 pixels below its end position: it starts 591 – 489 = 102 pixels below 
the bottom of the screen. Rather than From top=591 it could have said 
From top=489. Then the billboard would have started from just below 
the screen bottom. 
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Commentaries button 
The commentary button executes a Switch that checks what current 
audio track is used. That track becomes the default for the 
“comments” menu that than opens. 

 

When the “comments” menu opens, it is animated and slides in from 
the right side. That is to say: only the objects of animation group 1. The 
Comments menu also has all objects of the main menu and those 
remain motionless. For the viewer it looks like the “comments” menu 
is just the bit that slides in. In reality the “comments” menu consists of 
all objects of the main menu plus the objects of group 1. 
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The shield of the comments menu is positioned at left=1427. The 
animation starts at 493, that is left = 1427+493 = 1920: just outside the 
right edge of the screen. And it is sliding leftwards into the screen to its 
relative position left=0, which in absolute position is left=1427. 

 

 

Extras menu 

The Extras menu provides menu choices through text buttons that 
render the same text differently depending on its “normal”, “selected” 
or (seldom used in projects) “active” state. The button text for menu 
button “animatic” clearly has been rendered differently 3 times. 

 

All buttons have a “Press Left” action defined. This returns to the main 
menu and removes the Extras menu by sliding out (the objects in 
animation group 1) in the opposite way it came in (sliding to the 
bottom and off the screen). After the animation the main menu 
“menu” is active again. 
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Comments menu 

Like the Extras menu, the comments menu has textual buttons that 
are rendered differently depending on the state of the button. 

The “current” state highlights which audio track is currently active. It is 
represented by a small apple image (file marker2.png) next to the text.  

 

All buttons have a “Press Left” action defined. This returns to the main 
menu and removes the Extras menu by sliding out (the objects in 
animation group 1) in the opposite way it came in (sliding to the right 
and off screen). After the animation the main menu “menu” is active 
again. 
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Popup Menus 
The popup menus show while the movie plays.  

Depending on whether PIP is used, one of two popup menus is 
opened. They are identical but for the colour of a butterfly. It is pink 
when PIP is on, it is grey when PIP is off. 

 

The popup menus are almost identical to the main menus. Pressing the 
“Popup” remote control button will close the popup menu again. 

Popup menu 

This is the popup menu that belongs to the main movie, Big Buck 
Bunny. It resembles the main menu, but “play movie” is replaced by 
“main menu”. Also “Extras” is replaced by “Animatics”. 

 

When the ”popup” button is pressed on the remote-control, a Switch 
action is executed to figure out what popup menu to display: the one 
showing PIP has status “on” (coloured butterfly) or “off” (grey 
butterfly). See section “The movie and PIP” of this part on page 51. 

Main menu button 
The main menu button stops the movie reopens the main menu with 
its animations. The popup menu slides back below screen. 

Animatic button 
Activates the “PIP” status and replaces the current popup menu for an 
identical one but with the new PIP status – reflected in the colour of 
the butterfly. The only difference between the two menus is the use of 
the “marker 1” picture image. 
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If the popup menu selected has PIP off, the “On ENTER” multi-action 
sets it on and switches to the PIP menu: 

    

If the popup menu selected has PIP on, the “On ENTER” multi-action 
sets it off and switches to the non-PIP menu. 

 

Comments button 
The comments button opens the comments popup menu and sets the 
selected value to the current audio track. To do this, its “On Enter” 
action is an exclusive switch. 

 

Not by chance this selected button is also highlighted by the button’s 
“current” state apple. 

 

Movies 

There are several movies in this project. Most of them have nothing 
special and only an “End Action” defined to open a menu. Often the 
popup menu is limited and offers only to return to the main menu. The 
complexity is found in the main movie: Big Buck Bunny. 

• First there is the Common License movie. Nothing special, 
except its End Action opens the next movie 

• Second movie is the DynamicHD movie. Also has nothing 
special, except its End Action opens the main menu 

• The main menu starts with a short Intro movie. This movie has 
two chapters. The second one at the end of the movie is the 
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trigger to display the menu objects. The intro movie is found in 
the list of movies. 

• The main menu continues with its menu movie. This is a 
seamless continuation of the intro movie. The menu movie is 
not found in the list of movies. 

• The Bug Buck Bunny movie. The “main feature” movie. When 
it starts, a popup menu can be opened, but depending on 
whether PIP is active, a different popup menu opens. 

 

When the movie ends, its End Action reopens the main menu. 
It also has a PIP movie specified. This is also not found in the 
movie list. The PIP movie can be displayed in sync with the 
movie itself (to show some story board sketches). This leads to 
extra remote-control button actions. The PIP-specials are 
discussed in section” The movie and PIP” of this part on page 
51. 
The movie has 6 different audio tracks for music and 
commentaries. 

• Bloopers movie. Has popup “bonus” menu. That menu only 
allows you to go back to the main menu. 
At the end of the movie it reopens the Extras menu (different 
one if PIP is active) 

• Making Of: has a small bonus popup menu that only allows to 
go to the main menu. At the end of the movie it returns to the 
Extras menu 

• Deleted Scenes: same as “Making of” 

• Elephant Dream – a bonus B-movie. Its popup menu is “bonus” 
and only allows to return to the main menu. At the end of the 
movie it returns to the Extra menu. 
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Picture-in-Picture 
The Big Buck Bunny project is the only one to feature Picture-in-
Picture, or PIP for short. 

This feature can only be created by BDS MX as muxing two movies into 
one is a trick that the internal muxer of BDS can do, but the external 
tsMuxer was never designed (or envisioned) to do. 

The PIP feature can be switched on (showing story board pictures in 
sync with the main movie) or off (only the main movie showing). 

The menus and PIP 

This switch on/off is shown on the Extras menu by a differently 
coloured butterfly when the viewer selects the “animatics” menu 
option. This is a toggle type button: if PIP is on, it is switched off and 
vice versa. With each state of PIP belongs a different Extras menu 
(Extras if PIP=off, Extras PIP if PIP=on). Both are identical except for the 
picture element “marker 1 on” (coloured butterfly) and “marker 1 off” 
(grey butterfly). The toggle button “animatic” not only toggles the 
state of PIP, it also swaps the Extras menu. Because these look almost 
identical, to the viewer it appears nothing changes, except for the 
colour of the butterfly. 

The control logic behind the toggle switch is best illustrated by the 
picture below. You see that activating the “Animatic” button changes 
the PIP state and opens the other menu. 

 

Return to the main menu occurs when either: 

• The left arrow button is pressed (all buttons have their “Press 
LEFT” action set to Jump menu – so any button can be the 
“selected” one) 

• The down arrow button is pressed on the “Extras (PIP)” menu 
button at the bottom (that button has its “Press DOWN” 
action set to Jump menu) 

The same logic is applied for the same buttons in the popup menus. 
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The movie and PIP 

The movie that allows PIP also has a few extra actions defined for 
remote-control yellow button, as well as for the “popup” button. 
Actions that are not used in movies without PIP. 

 

The logic programmed into the project is shown above.  

The yellow button is defined for both popup menus as well as the 
movie itself. This way it always works when the movie or its popup 
menus are displayed. It sets the PIP movie within the main movie (“Full 
Screen”, PIP FS = off) or it overtakes the entire screen (PIP FS=on). 

The “popup” button logic resembles the same logic used for the main 
menu when it switches to the “Extras” menu. 

I inserted part of the logic in the project in a gray rectangle. I think this 
part is pointless and not needed. When the shown popup “menu” 
implies that PIP is off, there is no point in checking if PIP is on. And 
setting PIP full screen or not is equally irrelevant if it is not shown at all 
because PIP=off. This superfluous button action is probably the result 
of a popup menu clone of “menu PIP” to popup “menu”.  

When PIP=on, pressing the yellow button will toggle the PIP movie to 
be displayed in full screen or not. This yellow button action is defined 
for both the “menu PIP” popup as well as the movie itself. 

In case of the yellow button for the movie, the toggle is achieved 
through a Switch action that is defined as  

 

This full screen status only has effect if PIP is on. If not, neither 
condition is true (nor relevant) and the Switch results in “do nothing” 
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Bravo 
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The final product 
• Movie showing the resulting menu in action: 

https://youtu.be/8Rm3EZyIaAE  

• Sources in BDS project folder:  
https://blu-disc.net/download/examples/Bravo.zip  

• Movie instructing how to create the project: n/a 

Story 

Coverage of a Russian music band concert. 

Overview 

This blu-ray covers the 30th anniversary concert performance of a 
Russian music group “Bravo”. It allows to view the concert, a single 
play theme and switch between audio tracks. 

Interesting bits 

This is an ordinary blu-ray with menus and popup menus. The 
interesting thing is that the menu is built from many individual pieces 
(either as .png files or created from as many layers in a PhotoShop 
file). 

Rather than placing the bonus or setup menu on top of the main 
menu, they replace the main menu by sliding in (and covering the main 
menu items that do not slide out). 

There is chapter (song) animation in a manner like Force of Execution 
except the sliding ends at either first or last chapter menu (no carousel 
infinite loop). The chapters menus are shown in two film strips on top 
of each other. The bottom most strip replaces the main menu. 

There are so many songs, that there are 3 sets of 2 filmstrips with song 
titles that are reached by selecting a right (or left) arrow button. Each 
bottom film strip does have an “exit” button. 

 

https://youtu.be/8Rm3EZyIaAE
https://blu-disc.net/download/examples/Bravo.zip
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Ordinary menus 
Loading images 
The disc opens when loading results in showing the four “loading 
images” specified in Project Properties > Loading tab. 

 

This is not a loading animation – just four images shown that show the 
logo of the band’s 30 Years Tour fading in. You cannot specify any 
timings for the duration of this loading. If you wanted that, you should 
specify a “loading.anim” file as first (and only) image and specify in this 
file how many frames each image should be displayed. 

 

Main menu 

Main Intro 
The “First Play” as well as “Top Menu” both point to the “Main Intro” 
menu. This menu has no objects, so it must pass control to another 
menu in its “Enter” action. It does so to the “Main” menu, but not 
before it has played its intro movie. 

 

The “Intro” movie placeholder refers to the intro movie. The “Main 
Intro” also specifies the menu movie (it has to by BDS design) but it is 
never shown. 

Main 
The main menu has the same menu movie as the “Main Intro” menu. 
When it opens from “Main Intro” it starts by executing its animation. 

 

Two animations happen simultaneously: 

• All objects (needlessly grouped into “animation group 1”) are 
faded in from the blank “Intro Menu” screen in 8 frames 
(8/24th second) 
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• All objects slide into view to their final position from 300 pixels 
lower. Remember that the Y-direction is counted positive in 
downwards direction. The starting point at top=300 up to 
top=0 means the animation is upwards. 
The top of the movie frame is at absolute position top=779. 
Therefore, the animation starts from top=779+300=1079 
which is the bottom pixel row on screen. 

 

The menu is composed on 4 buttons with “normal” and “selected” 
states and a background that consists of a blue/black image. 

The normal states are the white texts on top of the background image 
and the “selected” states provide a blue rectangle with the same white 
text, but hiding the blue/black background picture. 

        

The background of the menu is composed of several static images. 
Together with the buttons they form the entire menu. 

 

Concert button 
The “Concert” button ultimately starts playing the concert movie from 
chapter 1 onwards. It has actions for “Right” (go to next menu button) 
and “Press ENTER” to start the movie. 
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This “Press ENTER” starts with an animation before setting the 
subtitles of the concert to Russian and start the concert movie at 
chapter 1. 

The animation is the reverse of opening “Main”: the entire menu (all 
objects, i.e. the filmstrip options) slide below screen and fade out in 9 
frames. 

 

Scenes Button 
The Scenes button has three action buttons: 

• “Left” moves to the Concert button 

• “Right” moves to the Bonus button 

• “Press ENTER” opens the Tracklist menu with all the songs 
performed by the band. This menu is not opened directly – 
some animation is performed first by calling the “Tracklist 1 
Enter” menu. 

 

Bonus button 
The bonus button has three actions: 

• “Left” to move to the Scenes button 

• “Right” to move to the Settings button 

• “Press ENTER” that opens the bonus menu, which is a filmstrip 
that replaces the main menu by sliding in (pushing the “main” 
menu objects out of sight at the left). 

Setup Button 
The Setup button is the right-most button. It only has two actions: 

• “Left” to move to the Bonus button 

• “On ENTER” open the Setup menu (a filmstrip that replaces 
the main menu by sliding in) but perform a Switch to make the 
correct button the default selected one: 

o if the audio is set to track 1 then open the Setup menu 
selecting the “Dolby Digital 5.1” button as default 

o if the audio is set to track 2, open the Setup menu with 
the “TrueHD” button selected. 
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Bonus Menu 

The Bonus menu opens when the “Bonus” button on the main menu is 
pressed. It starts with an animation that replaces the main menu by 
the bonus menu through a sliding animation. 

 

It slides in from left=1741 to its final relative position left=0. The 
absolute position left=1741 is the right-end side of the “exit” button. 

 

The buttons of the “Main” menu have become static pictures while the 
buttons of the “Bonus” menu are true buttons. The images of both are 
aligned in a long strip. The “Main” objects at the start, the “Bonus” 
objects following. Animation by the “Bonus” menu results in a sliding 
of both “Main” objects and “Bonus” objects simultaneously as if they 
are a single film strip that is moved left over 5 film frames.  

The (left,top)=(0.0) relative positions of the “Main” objects in the 
“Bonus” menu are positioned well outside the left side of the screen. 
For example, the “play concert movie” frame relative position (0,0) is 
in absolute terms (-1365, 857). A left shift to (0,0) over 1741 pixels 
means that the “play concert movie” picture starts at absolute position 
left=1741-1365=376. And this is exactly the left position this (then) 
button takes in the “Main” menu. 

The end result is a displayed “Bonus” menu with 5 buttons: 

• Intro (to Yellow Boots) 

• Stand (By Me) 

• Guitar (mania Evgenia Khavtan) 

• Exit (to main menu) 

All buttons, except for “Exit”, activate a movie. They all animate the 
menu downwards and out of sight and at the same time let it fade out. 
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The “Exit” button reopens the “main” menu by sliding all items of the 
“Bonus” menu to the right over 1741 pixels. This is the reverse action 
as when the “Bonus” button is pressed in the “Main” menu. The result 
is that the “Bonus” buttons are sliding out of sight at the righthand 
side of the screen, while from the left the “Main” button pictures slide 
back in. Once the animation ends, the main menu is displayed and the 
“Main” button pictures become true buttons again. 

Note that the “main” menu is invoked without the [anm/act 1] 
opening animation: the objects of the main menu do not animate from 
the bottom to their position but are already there – at precisely the 
spot where the animated versions of the buttons moved to. 

 

 

Setup Menu 

The “Setup” menu only has three buttons and some more frames as 
picture embellishment. 

 

When it is opened from the “Setup”  button on the main menu, it 
executes a Switch action to open the “Setup” menu but set the proper 
button as default, depending on the current audio track. 

 

The “Bonus” menu opens by executing its animation. 

 

That moves all objects (all film frames of “Bonus”) to the left – 
including the “Main” button pictures that move out of sight beyond 
the left hand edge of the screen. 

The only thing the two audio buttons do is set the right audio track (1 
for Dolby, 2 for TrueHD). It does not employ the “Current” state of the 
buttons. 

The “Exit” button reopens the “main” menu by sliding all items of the 
“Setup” menu to the right over 1741 pixels. The “Setup” buttons move 
out of sight at the right hand edge of the screen, while the main menu 
buttons move back in from the left hand side. Once the animation 
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ends, the “Main” button pictures are precisely at the spot where their 
button counterparts in “Main” are positioned. When “Main” is 
activated again the viewer experiences that the “Main” buttons are 
real buttons again. 

Note that the “main” menu is invoked without the [anm/act 1] 
opening animation: the objects of the main menu do not animate from 
the bottom to their position but are already there. 

 

Scenes Menu 

The song titles (or chapters) are indirectly invoked from the “Scenes” 
button on the “Main” menu. When pressed, the “On ENTER” action for 
the “Scenes” button first opens the “Tracklist 1 Enter” menu.  

The song titles come in 3 menus of 2 film strips. The first two strips are 
shown below. 

 

The composition of the two film strips is a little peculiar. It can be 
broken down to the components shown below. To get the menu as 
displayed, all objects must be superimposed on each other. 

 

The larger film strip object is positioned above the smaller one, so this 
one disappears entirely if the sprocket holes are aligned. Two pictures 
are placed above each other and above the larger black film strip. The 
song title buttons have a white text in their “normal” state and a blue 
rectangle with white text when the button is in “selected” state. They 
reside at the top of the stack of menu objects. 

Tracklist 1 Enter 
The “Tracklist 1 Enter” menu is an animation menu only. It has two 
animation groups: 

• Group 1 – bottom row. Slides over 1741 pixels to the left – 
bringing the “main” menu objects out of sight and the first 
song titles in position 
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• Group 2 – top row. New objects, slide upwards over 220 pixels 
to their final position. There is a clipping area that shows all 
animation between the top of the screen (0) and 800 pixel 
rows lower (up to 280 above the bottom of the screen). 
The first song, DOBRYI VECHER MOSKVA (Good Evening, 
Moscow), ends on (left,top)=(208,672). When moving over 220 
pixels upwards, it means it started at top=672+220=892 – just 
below the clipping area. 

 

The “Tracklist 1 Enter” transfers control to “Tracklist 1” menu and set 
the first song title button (DOBRYI VECHER MOSKVA) as default 
button. 

 

Tracklist 1 
The “Tracklist 1” menu is a real menu with buttons. Each button 
activates the movie at the chapter where the title song starts. Before 
playing the movie from that chapter onwards, it animates the 
disappearance of the track menus by animating all objects (needlessly 
grouped in animation group 3 – “All objects” would have worked also). 

 

The animation moves all objects downwards over 660 pixels – below 
the bottom of the screen. At the same time they fade out. 

As last part, the action is executed: the movie starts at the chosen 
song. 

 

Exit button 
The Exit button is different from the song title buttons. It closes the 
tracklist menu and transfers control to the main menu. This is done via 
an animation menu “Tracklist 1 Exit” (or 2 or 3) that only has pictures. 

 

Next (Previous) button 
Because there are more than one scenes menu, these track menus 
have arrow buttons to move to the next or previous set of track 
menus. The buttons do not appear at the begin or end of the track lists 
– unlike a carousel they do not provide an infinite loop. You need to 
move forwards or backwards in the list of tracks. 
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The buttons are actually images. Their work is performed by an action 
of the button before the arrow (“Right” action) or following the arrow 
(“Left” action). 

A button with a “Right” action simply opens the next tracklist menu. 

 

The new default song title becomes the first one on that menu. The 
chosen menu first performs an animation. 

 

This entails an animation of all twelve buttons (15 songs + exit button) 
by sliding them to the left over 1906 pixels. This lets the old song titles 
disappear at the left, and the new titles appear from the right. 

Tracklist 1 Exit 
The “Tracklist 1 Exit” menu is the opposite of “Tracklist 1 Enter”. It also 
consists entirely of pictures, collected in two animation groups. 

• Group 1 is the bottom row. It slides to the right over 1741 
pixels, moving the track buttons out of sight beyond the right 
hand edge of the screen, while moving in the main menu 
pictures from the left.  

• Group 2 is the top row. They are moved down over 220 pixels, 
below the clipping area bottom row and become invisible. 

 

The final action is transfer to the “Main” menu. The picture buttons 
of”Tracklist 1 Exit” have slid precisely to the position where the real 
buttons on the “Main” menu are positioned. Transfer of control to 
“Main” therefore activates the buttons that were just pictures before. 

 

Note again that “Main” is invoked without its [anm/act 1]. The menu 
opens without performing its animation (the  buttons do not move in 
from the bottom). 
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Popup menus 
The popup menus are largely cloned copies of their main menu 
counterparts. They have the same names but with “pop” added as 
prefix. 

Not all movies open the same “pop main” popup menu: 

• Pop Main – is opened when “Concert” movie plays 

• Pop Bonus – opened by “bonus intro” movie, “bonus Stand” 
and “bonus Backstage”. They all open with a different selected 
button. 

• No popup – when “bonus Guitar” movie plays 

Pop Main 

The popup main menu is identical to the Main menu, except that the 
first button “Concert Bravo Stadium Live” has been replaced by 
“Return to main menu” and the “Bonus” button has been removed. 

 

The final entry closes the popup menu (which would also happen if 
you press the “popup” button on the remote-control again. 

Popup Setup 

This is opened through popup Main selecting and activating the 
btnSetup button. The Press Enter action has a Switch action that 
determines what button on the menu to select, depending on the 
current audio setting.  

 

And the opening of the popup Setup menu starts with the same 
animation as the Setup main menu. 

Pop Tracklist 

All “pop Tracklist *” popup menus are clones of the main “Tracklist *” 
menus and act the same. 

Pop Bonus 

The “pop Bonus” menu is the popup menu while the “bonus Intro”, 
“bonus Stand” or “bonus Backstage” movie plays. Each movie opens 
the popup with a different selected button. 

It is identical to the main menu “Bonus” except that the “exit to main 
menu” button at the end is replaced by a “close popup” button. Other 
than that, it is the same. 
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Pop Guitar 

Unique for the popup menus are the “pop Guitar *” menus. They have 
no main menu equivalent.  

When from main menu Bonus or popup Bonus the “Guitarmania” 
button is selected, the “bonus Guitar” movie starts playing. 

Its “End Action” is to open the “pop Guitar 2” menu while it starts 
playing the same movie again, “bonus guitar”, from playmark (chapter) 
107 which happens to be the one but last chapter of the movie. 

This movie has many chapter marks set for the many guitars that can 
be selected (108 in total, number 1 being always the start of the 
movie). 

 

The popup menu shows with a number of buttons, all with a picture of 
a specific guitar. They are numbered from 0 (top left) to 25 (bottom 
right).  

 

Each guitar button has navigation defined to move to the next or 
previous guitar – both in horizontal as well as vertical direction. An 
example is given for guitar 21, which is the fourth from the left on the 
bottom row. When the selected guitar is activated, the “bonus Guitar” 
movie starts (in this case at chapter 99 – but it will continue from there 
to the following chapters). Each guitar occupies two chapters. 
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Another unique feature is that the buttons have a “current” state as a 
bulls eye to indicate what guitar is currently playing. This is because 
the “Highlight” section for button “btn select guitar 21” is filled in. 

  

The when chapter 99 or 100 is current, the bullseye is shown. 

When the “btnGuitarNext” is pressed (left most button), the transition 
menu is called to slide to the previous pop menu, ending in “pop 
Guitar 1”  

 

That menu also has a “btnGuitarNext” that does the reverse of the 
other menu: it slides back from popup “pop Guitar 1” to “pop Guitar 2” 
via animation. The guitar buttons are different from the other guitar 
menu (obviously) and also activate different chapters in the guitar 
movie. Guitar number 0 at the top left, starts at chapter 3. The final 
guitar 26 starts at chapter 55. 
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Two different sliding animation menus are used. It could have been 
one, using two different sets of [anm/act] where one set slides from 1 
to 2 and the other from 2 to 1. 
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The King’s Speech 
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The final product 
• Movie showing the resulting menu in action: 

https://youtu.be/LwrszM9xOyQ  

• Sources in BDS project folder:  
https://blu-disc.net/download/examples/KingsSpeech.zip  

• Movie instructing how to create the project: n/a 

Story 

The story of King George VI, his impromptu ascension to the throne of 
the British Empire in 1936, and the speech therapist who helped the 
unsure monarch overcome his stammer.  

118 min, 2010, USA, director: Tom Hooper 

Overview 

The “King’s Speech” looks like a basic BDS project. When the disc is 
loaded a short animation is played before the main menu is shown as 
point of departure to go to other menus or start the movie. This main 
menu first runs an intro movie in the background before looping the 
menu movie. The menu objects show at the end of the intro movie. 

Those follow-on menus look like the previous menu plus new objects 
(the only part with buttons). 

The popup menu for the main movie looks like the main menu but has 
a “return to main menu” on the spot where the main menu has a “play 
movie”. 

The movie has a chapter menu also. Because of the many chapters, 
several chapter menus are needed.  

Interesting bits 

This project is interesting because: 

• It uses loading animation 

• It has a main menu with intro movie 

• It uses textual buttons that render differently for different 
button states 

• It has a carousel chapter menu handling 

Especially the way it handles the change in chapter menus makes this 
project different from others. The change in chapter image seems like 
an infinite loop (“carousel”) where you move from chapter to chapter. 
The chapter images slide under the cursor from left to right, shifting 
position by one chapter at the time. 

Carousel menus are also done in “Force of Execution” but with a 
difference. In that project a set of chapter images is shown and the 
entire range of chapter images slides away to make room for another 
set of chapter images. 

In “The King’s Speech” only thee chapter images are shown. The 
middle one is always the selected one. If you want to move to the 

https://youtu.be/LwrszM9xOyQ
https://blu-disc.net/download/examples/KingsSpeech.zip
https://www.imdb.com/name/nm0454377/?ref_=
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chapter at the left, that chapter moves to the right so it becomes the 
middle chapter and gets selected. If you want the chapter at the right, 
that moves to the left and becomes center chapter. 

This “shifting by one” is achieved by manually animating each chapter 
image to slide over 1 chapter image width. This “shift left” or “shift 
right” results in 3 animations where all three chapter images slide one 
position to the left or right. And additional 3 animations are used to 
reduce the visibility of all chapter images, except for the one that is 
selected: the one in the middle. 
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Ordinary menus 

Main menu 

Loading animation 
When the disc is inserted, it opens the main menu. But before doing 
so, it plays an animation specified in a loading.anim file specified in 
Project properties > Loading tab. 

 

This .anim file contains 17 images that are shown one after the other. 
Each image is shown for the duration of 2 frames. Five of them are 
shown below. In animation you see the arrow rotating and slowly 
fading away.. 

     

After the disc loading animation, the main menu is opened. But this 
menu starts with an intro movie. This movie has 2 chapters: its start 
and end. The end chapter is the point where the menu objects show. 
There are no static objects to show – only three buttons. These have 
been grouped in an “animation group 1” and their appearance is 
controlled by the main menu’s animation on entrance. 

 

The animation is a simple fade in of all 3 button objects within 4 
frames.  

 

There seems no need to put all objects in an animation group. If all 
objects take part in the animation, the “All objects” rather than “group 
1” would accomplish the same result. 

 

After the animation, the main menu objects are shown. The menu Is 
rather basic: just three objects as text buttons, shown on top of the 
background movie. 

• Play (text: play movie) 

• Scenes (text: scene selection) 

• Options (text: sound & subtitles) 
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The “normal” state of the three buttons is shown above. The 
“selected” state simply adds parentheses around them. This is a 
situation where the states of a button do not overlap the way the 
often do. 

 

The “active” state is also defined (you don’t see that often). It is 
identical to the “selected” parentheses but has a different (bluish) 
colour. 

 

(Note 1: the King’s Speech movie shows these three buttons on a 
brown background, just like the popup menus do. This may be a last 
minute change not updated in the project example files. You may wish 
to add the “popup.png” background as an extra picture object to the 
main menu too, positioned as the last object of the menu. The same 
then applies to the “options to main” menu). 

 

(Note 2: I’m told that this brown background is actually part of the 
menu movie that plays in the main menu and is authored as such in a 
video editor. That of course is another way to visually highlight the 
menu. This way it also costs no pixels in the maximum pixel count of 7 
900 000 reserved for all menus. For the popup menu you do need a 
background as obviously the playing movie doesn’t contain it!) 

The three buttons are linked for navigation: 

• Move right from “play” to arrive at “scenes”.  

• Move left from “options” to arrive at “scenes” 

• Move left from “scenes” to arrive at “play” 

• Move right from “scenes” to arrive at “options” 

Rather than immediately changing from “selected” state back to 
“normal” state, the previously selected button returns to its normal 
state by fading out its selected state in 4 frames. No “animation group” 
is needed: you can animate all buttons in “selected state”. 

As example, the “Scenes” button fades its “selected” state image 
(parentheses) when either the left or right control button is pressed. 
What remains is the “normal” state of the “scenes” button: text only. 
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Play button 
The “On ENTER” action for the “play” button is obvious: play the 
movie. 

 

Scenes button 
The “scenes” button has a switch action for “On ENTER” to ensure that 
the right chapter menu (there are 22 of them) is opened and that the 
current movie chapter is taken as selected button. 
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At simulation time, but also when the main menu is shown when the 
disc is played, no movie is playing. In that case, chapter 0 is returned. 
In the movie’s popup menu the chapter number would never be zero. 
It would start at 1 (begin of the movie) to the last chapter number (in 
this film The King’s Speech it is 23 at the very end).  

Therefore, in the main menu the first condition is always true. It opens 
the first scenes menu and selects the image belonging to chapter 1. 
This menu is shown below. 

 

Options button 
The “options” button has an “On ENTER” action that opens the 
“options” menu, starting with its animation. 

 

After the animations, the “Selected” state (by parentheses) is shown 
for “English” (button “SoundEng”).  

The “Current” state (light brownish background) is also shown. 
Without prior choice, they are set to audio “English” and subtitles 
“off”. This setting is so defined in the Project Properties setting. 

 

The final result of activating the “Sound & Subtitles” choice is shown 
below in its simulation mode. 

 

Options menu 

The options menu is a collection of the main menu (now consisting of 
only pictures) and the additional brown background with audio and 
subtitle options.  

When it opens, it starts with its animation. 
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The properties cannot show all of the animation, so it states 
[Advanced] – which means that several groups are animated 
differently and listed in the “Advanced” section of the animation 
window. 

  

The opening animation increases the visibility of the main menu parts. 
The “play” and “scenes” pictures of the main menu are part of 
animation group 2. This group is faded in from transparent (0) to 
almost opaque 230. The “options” picture, in its own animation group 
3, is faded in less (0 to 200). 

The unique part of the options menu has five buttons. Their “normal” 
state is the text, the “selected” state is formed by the two 
parentheses, the “current” state is formed by the same text, but with 
light brownish background. All three states together show up in the 
Designer View window of the menu. 

 

The working of each of the buttons is pretty standard stuff. As an 
example, the properties for “subtitles off” are shown.  
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• Press left removes the “selected” status parentheses by fading 
them away 

• Press ENTER sets the subtitle track to 0 (=off). The Off state 
(when selected) must also highlight through its “current” state 
as specified in the “highlight” section: highlight if subtitle track 
= 0 while movie plays 

• Press down removes the entire options menu and opens an in-
between menu “Options to Main” (which in turn will invoke 
the ”main menu” when finished) . This is a picture-only menu 
with all objects in their “normal” state representation. 

 
When it opens, it fades the entire brown menu block to 
transparency (alpha = 0). Once gone, it relinquishes control to 
the main menu. 
 
An in-between menu is needed since the picture parts of the 
main menu should not fade away to suddenly pop back into 
existence when the main menu is opened. The options menu 
can perform some animation on opening, but not on closing.  
If you don’t care about fading away the options part, you may 
simply directly switch to the main menu. The specific part of 
the options menu then disappears in an instant rather than 
fading away. 
 
[Advanced] animation is used when the Down arrow is used, 
but I don’t know why: it specifies groups are sliding out with 
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identical start- and end positions – nothing slides visibly. And it 
fades in group 4 that is positioned below the screen (at top = 
1098) and is therefore never seen. 

Chapters menu 

The Chapters menu is a complicated one. There are 22 chapters in the 
movie. Each chapter menu shows only 3 chapters. The middle one is 
the currently selected one (press on OK and the movie starts playing at 
that chapter). There are 22 chapter menus: one menu for each of the 
chapters that are selected and in the middle position. 

 

The middle chapter image is called “btnCurScn” or “the current scene” 
(not to be confused with its “current” state). It is part of animation 
groups 3 and 7. It is completely opaque and thus visible. 

The chapters before and after the current scene are called the 
“btnLeftScn” and “btnRightScn” for previous and next chapter. They 
are slightly less opaque (“effect” property sets them at alpha=150). 

 

 

The left scene is part of animation groups 4 and 9, the right scene of 
groups 4 and 8. 

 

Menu for chapters 22, 1 and 2 
Menu navigation 
When the chapter menu opens from the main menu, it always opens 
on Chapter 1, as explained earlier. 
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The menu has 3 buttons. Only the btnCurScn has any actions defined. 
The other two could have been image objects also. 

When you press the “Left” button, you move from Chapter 1 to the 
last Chapter 22. If you press “Right” you move to Chapter 2. Rather 
than actually going to the left or to the right, the selection remains in 
the middle, but the chapter images (and buttons) move so that the 
new chapter is again in the middle. 

What happens in BDS is that one menu with Chapter 1 in the middle 
(“scenes 1”), is replaced by another menu that has either Chapter 22 
(“scenes 22”) or Chapter 2 (“scenes 2”) in the middle. 

This replacement occurs in two steps: 

• The old menu executes the animation that is specified when 
the left or right button is pressed 

• The old menu disappears and opens the new menu with next 
or previous chapter in the middle. 

If you look at the actions specified for the button in the middle you see 
the new menu that replaces the current one, after the animation has 
been executed. This animation will give the illusion of a sliding set of 
chapter images before the new chapter menu is displayed. 
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Press left: previous chapter 
If you press Left, an animation occurs. When completed, a new menu 
is displayed (“scenes 22”). This has the btnCurScn (the one in the 
middle) set to Chapter 22. 

The animations are needed to move 3 buttons one step to the right 
and provide the viewer with the illusion of sliding chapter images: 

• The chapter button at the right moves one position to the right 
and thereby disappears 

• The chapter button in the middle moves to the right and 
becomes the chapter button on the right 

• An unseen one moves in from the left and takes the position of 
the left chapter image. 

 

The animation that precedes the new menu is a lengthly one. All 
animations happen at the same time and within a duration of 10 
frames (10/24th second). 

Because 3 buttons need to shift position (a “slide” animation – moving 
one position to the right) and their transparency modified (a “fade” 
animation), there are 3 x 2 = 6 animations defined. 

The fading moves from fully transparent (alpha=0) via partly 
transparent (alpha=150) to fully opaque (alpha=255).  
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When you press the Left button, the menu buttons shift to the right 
over a distance of the chapter image width.  

• Group 9 is the btnLeftScn and it slides exactly 293 pixels to the 
right: it moves one chapter position to the right. Thereby it 
moves from left to the center position. 

 
 

• The btnLeftScn (group 9 all by itself) reduces its transparency 
from alpha=150 (set initially by its “Effect” property) to 
opaque 255. Firmly visible in the center. 

• Group 6 stands for a single picture outside the screen. It is the 
one that is going to fill the now vacant left chapter image 
position. 
Its initial position is at left = –305 (width 259, a chapter image) 
– stored well out of sight. 
It slides in from relative position left=550 (absolute  
-305+550=245) to relative position 843 (absolute  
-305+843=538). All pixels up to left=468 are outside the 
clipping area and remain invisible.  
The slide from 245 therefore starts partly behind the clipping 
area curtains. Partly, because the right edge of the chapter 
image (259 pixels wide) is at (245+259=) 504 and “sticks out” 
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(for 504-468=36 pixels) at the start of the animation. The 
entire chapter image is visible after the animation.  

 
• Now that group 6 (the left chapter image) is in place, its 

transparency is set to alpha=150 

• Next, group 7 is animated. This is the btnCurScn, the “old” 
chapter image in the middle (showing Chapter 1). It also has to 
slide to the right into the right most button position. There is 
no clipping area needed, and the slide is from its current 
relative position of (left,top)=(0,0) to (293,0). This shift covers 
exactly one chapter image plus separation (259+34). 

• When the group 7 is moved in position, its transparency is set 
to alpha=150. It is no longer fully visible (alpha=255) 

• The right most chapter image button btnRightScn is set as 
group 8. This group is animated to slide 293 pixels to the right. 
The chapter should no longer be visible. A clipping area that 
ends at left=1454 ensures this happens. The right chapter 
image is originally positioned at left=1124. After the animation 
it is at left=1124+293=1417. That means that a small part 
(between left=1417 and 1454) remains visible. 

• Finally, group 8 transparency is increased from alpha=150 to 0: 
fully transparent.  

After all three chapter images have moved one position to the right, 
the new “scenes 22” menu is displayed and all results of the animation 
in the “scenes 1” menu are lost. 

Press Right: next chapter 
The movement in opposite direction is the mirror image of the Press 
Left actions and animations. 

This time all chapter images move one position to the left. The left 
most image disappears, the right most image goes center stage. Its 
vacancy on the right is filled in by a new chapter image, stored well out 
of sight but moving into position.  

The new chapter images are partly transparent (alpha=150) except for 
the central chapter that is completely opaque. 

We’ll not repeat all steps in detail. Suffice some pictures that illustrate 
the animations – mostly in mirror reversed order to the Press Left 
situation. 
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The visual animation is depicted below for Chapter 1 becoming 
Chapter 2. 

 

The animations for btnCurScn (=Chapter 1) when the right button is 
pressed are shown below. 

Animation groups are again: 

• Group 8 – the chapter at the right side that will become the 
newly selected chapter (Chapter 2). Transparency reduced by 
setting alpha=255 

• Group 5 – the new next chapter (3) image, positioned well of 
screen at the right side. Initially at left=1967 (screen right edge 
is 1919). Slides in and transparency set to alpha=150 

• Group 7 – the current chapter (Chapter 1) that is demoted to 
the leftmost chapter button at transparency alpha=150. 

• Group 9 – the leftmost chapter button (Chapter 22) that is 
moved off screen. Transparency set to alpha=0 (fully 
transparent) 
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All the other chapter menus 
As indicated earlier, the movie has 22 chapters and thus 22 chapter 
menus, each with one chapter in the center position and the two 
adjacent chapters at the left or right side of the center, are required. 

That’s a lot of work. Except… if you create all chapter menus 
identically. Creating one in full, clone 21 copies. For this look in Project 
Tree under the “menus” section. Select the one menu fully defined 
and by right mouse click select “Clone tree item” and give the clone 
copy a unique name.  

The cloning also copied all actions and animations. Each menu uses the 
same animation groups, so it all works. 

The manual labour still remains in personalizing the chapter menus. 
The clone copy points to the exact same chapter images. You need to 
modify that so each menu has its own trio of chapter images. That 
means that the “normal” state of the btnCurScn, btnLeftScn and 
btnRightScn must be updated to use the proper chapter image. 

For example, “scenes 1” has chapters 22, 1 and 2; “scenes 2” has 
chapters 1, 2 and 3 and so on. 

You create chapter thumbnails the same way as described for Force of 
Execution. The BDS chapter generator in its “scenes” window can be of 
great help here. See the part on Force of Execution on page 9 for 
details. 
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Popup menus 
The popup menus are copies of the normal menus, except that in the 
main popup the item “return to main menu” replaces the ”play 
movie”. 

The movie 

The movie has a few properties specified: 

 

The popup menu is opened when the “Popup menu” button is pressed 
on the remote-control. After the movie finishes, the disc returns to the 
main menu, selecting the “play” button. 

Popup menus 

Because the popup is displayed against the movie, it has a fixed brown 
bar in which the menu buttons are placed. 

 

The audio/subtitle menu and the chapter menus are cloned from the 
“menus” section into the “popup menus” section. (Select a menu and 
at right mouse click select “Clone (all) between main and popup”. 

If you choose “all” then you may need to delete all menus that you 
don’t want to use as popup menu. 

Jump to main menu 
When the main menu is selected, an in-between menu is called 
“popup jump main” that consists of an entirely black screen that fades 
in. This is accomplished by placing the black object at the top of the 
objects so it covers all others. By fading in from transparency to 
opaque (black screen), the other picture objects slowly disappear from 
view. 

Once the screen is black, the transfer is made to the real main menu. 
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From Options back to popup 

Just like the main menu handling, there is an “options to main” menu. 
(Clearly a clone, more appropriate would have been “options to 
popup”). 

The Chapters menu 

The popup menu has a slightly different handing of the chapter menu. 
Unlike the main menu, currently a movie is playing while the popup 
menu is shown. When the Chapter menu is selected from the popup, 
the chapter menu is chosen that has the current playing chapter 
selected. 

It makes full use of the switch action already shown earlier and 
executed when the “scenes” button is pressed and its “Press ENTER” 
starts the switch. 

 

Here the “chapter” value is never 0 (as in main menu) but always 1 or 
more. If a chapter at the very end is defined (chapter 23), the chapter 
before it is used for chapter selection. 
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The switch clearly indicates that for a chapter N the corresponding 
ScenesN menu must be opened using its btnCurScn as default button. 
This is the middle button showing the chapter image of chapter N. 
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Senna 
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The final product 
• Movie showing the resulting menu in action: 

https://youtu.be/E1r-nxgL0H0  

• Sources in BDS project folder:  
https://blu-disc.net/download/examples/Senna.zip  

• Movie instructing how to create the project: n/a 

Story 

A documentary on Brazilian Formula One racing driver Ayrton Senna, 
who won the F1 world championship three times before his death at 
age 34.  

106 min, 2011, France, director: Asif Kapadia 

Overview 

“Senna” is a regular movie with a main menu as departure to show 
either “Setup” or “Chapter menu” or to start the movie. 

The chapter menus show a set of chapters and are the menus replace 
each other instantaneously. 

Like the “Apollo 13” blu-ray the menu animation opens it up from the 
left and also squeezes back to left. 

Interesting bits 

The transition between menus is interesting. Rather than simply 
replacing one by the other (with or without keeping the “old” menu 
objects as static pictures) some menu objects are animated to squeeze 
to small size to give way to the new menu. And expand again upon 
return. 

The animation of several “old” menu objects creates this illusion 
before the new menu is opened. 

https://youtu.be/E1r-nxgL0H0
https://blu-disc.net/download/examples/Senna.zip
https://www.imdb.com/name/nm0438090/?ref_=tt_ov_dr
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Ordinary menus 
The project starts with an opening main menu with a menu movie 
background. The menu parts are animated to shrink to the left side to 
show other menus. Or expand back when you return to the main 
menu. There are no intro movies used in the menus. A similar 
approach is used on the “Apollo 13” blu-ray. 

Main menu 

Main Menu Int1 
The disc opens with the “Main Menu In1” as specified in First Play. This 
is a picture-only menu and therefore needs to be followed on by 
another menu, being “Main Menu 1”. This is achieved by specifying it 
in the “Enter” action property of the menu. This action is performed 
once the specified animation is completed. In fact, that is the only 
reason for “Main Menu In1”: animate the menu that, after animation, 
looks like the true main menu. 

  

The animation consists of two parallel executing streams (hence 
“[Advanced]”: both streams are added to the “Advanced” part of the 
animation). Each stream has its own “animation group” 1 or 2. They 
show the viewer an expanding menu that is moving in from left to 
right. 
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All menu objects and their names are shown below – slightly displaced 
to show them all individually. 

 

The yellow object BG TOP is the only member of animation group 1. It 
slides in somewhat from the left. It will occupy the left-most part of 
the screen. 

 

It is animated from 254 pixels to the left to end up at the relative 
(left,top)=(0,0) which happens to be absolute (left,top)=(-14,-6).  
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So it slides from (left,top)=(-14-254,-6-0) = (-268,-6) to its position (-
14,-6). The animation happens in 16 frames – usually 16/24th second. 

 

Animation group 2 consists of all other elements. They also slide in 
from the left but more than the yellow block in group 1: they all slide 
over 580 pixels. But all objects slide as much relative to each other so 
they keep their relative position to each other. For example, the BG1 
curve ends at left= – 14 whilst the grey block BG2 ends at left=72. 

When the animation ends, the three main menu choices (play movie, 
chapters, setup) are also shown and the “play movie” button shows its 
selected state (a green rectangle below the text). 
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Note: Picture BG2 is partly transparent in the demonstration movie 
(can be set in its “Effects” property). The background movie can be 
seen through this picture. The sample project has no transparency. 

Main Menu 1 
After the animation, an identical looking Main Menu 1 takes over (to 
be sure it works out that way, start creating Main Menu 1 and then 
use the dropdown list to select clone tree item as static). 

Here texts for “play movie”, “chapters” and “setup” represent the 
“normal” state of the three buttons, a green rectangle behind the text 
forms the “selected” state. 

 

 

The main menu also has some animation when a selection is made. All 
objects are grouped into “animation group 1” except the BG1 yellow 
block at the left. 

If the “OK” or “Right” button on the remote-control is pressed, the 
following happens: 

• “Play” reduces the menu (and it gets removed by the play 
movie action): it calls Main Menu Out [anm/act 1]. It does this 
if you use the “Right” button or “OK”  

• “Chapters” opens menu Scenes Pre [anm/act 1] but not before 
it has performed animation on its own menu. 

• “Setup” opens menu Setup Pre [anm/act 1] but not before it 
has performed animation on its own menu. 

Both “Chapters” and “Setup” perform the same animation: they move 
all elements 266 pixels to the left (in 10 frames) which looks like sliding 
it under the yellow arc that remains put as it is not part of any 
animation. 
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Once the animation completes, the entire menu is removed and 
replaced by the one belonging to Chapters (“Scenes Pre”) or Setup 
(“Setup Pre”). 

Main Menu Out 
This menu is opened by “Play Movie” after the animation. 

It contains only picture elements and therefore must have an action 
defined once its own animation is completed. This action is simple: it 
starts playing the movie. 

The animation acts on both animation groups.  Again the yellow left-
most BG1 is in group 1, all other objects are in group 2. 

 

The animation is the reverse of the animation on opening with “Main 
Menu In1”. Group 1 slides to the left (in 16 frsames), out of screen 
sight, over 280 pixels, whilst group 2 slides to the left over 640 pixels. 
With a screen that now only shows the menu movie, control is passed 
to the movie. The screen clears, the movie starts. 

Chapters 

The Chapters menu choice opens the chapter (or scenes) menus. There 
are so many chapters that the chapter thumbnails have been spread 
over five scenes menus (“Main Scenes 1” to “Main Scenes 5”). Rather 
than a simple jump between chapter menus, these too have been 
animated in a carousel-like manner. We will not discuss this again as 
the principle is the same as described for “Force of Execution”. 

Scenes Pre 
Before opening the chapter menu, the screen menu is animated again. 
After the choice for “chapters” was made on the main menu, it slid to 
the left. When “Scenes Pre” takes over, it performs its own animation, 
which is to extend the menu again, but with different items than the 
main menu: the chapter menus. 



94 Blu Disc Studio Live 

The “Scenes Pre” menu starts with the end-result of the shrinking by 
the main menu. 

 

Only just the three main menu choices are still visible. The animation 
of “Scenes Pre” performs a fade on these objects so they completely 
disappear. 

 

Then it hands over control to another menu, “Main Scenes 11”.  

Main Scenes 11 
The “Main Scenes 11” menu also consists only of static objects. 
Therefore, it too is only used to animate something, before it needs to 
pass control to another menu, the real chapter menu from where the 
viewer can select a chapter to play. It opens with the first chapter 
menu, first chapter: “Main Scenes 1 [01]”. 

 

This will be different for a similar set of popup menus where the menu 
opened will contain the active chapter. 

What animation happens from the “nothing” left by “Scenes Pre” to 
the final “Main Scenes 1” menu? 
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Several animation groups are defined: 

• The grey block, its text “Chapters” (text, green side line, fading 
background behind the text) are together in animation group 1 

• The chapter menus (1-4, 5-8, 9-12, 13-16), chapter thumbnails 
and chapter numbers are together in animation group 2 

• The rest of the menu remains static and does not move. To 
this the black curve, the < pointer belong 

 

Both groups perform the same animation in 14 frames, but their slide 
from left to right is different.  

Group 1 comes from far away out of screen sight at the left and travel 
over 450 pixels to their standard position given in the (left,top) 
properties of the objects. Their relative position to other members of 
the group remains unchanged. The middle gray block moves to 
left=115 (which is its relative left=0). 

Group 2 slides much further (as it will occupy almost the width of the 
screen). It slides over 1594 pixels to the right. The first chapter image 
will end at left=676 (its relative left=0), last one at left=1477. Although 
the screen is 1920 pixels wide, a slide over almost 1600 pixels suffices 
as it is covered by the arcs on the left. Their object position is higher 
than that of the chapter images and hence they can cover the images. 
Otherwise a clipping area might be called for. 

Once the sliding ends, control is handed over to menu “Main Scenes 
1”. 
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Main Scenes 1 (and others) and P1 
The “Main Scenes 1” menu has no animation. All curved parts at the 
left are picture images, the chapter images are true buttons: 

• Normal state: the image of the chapter 

• Selected state: same image, but with green edge 

Each button has a “Press ENTER” action defined that immediately 
starts the movie from that chapter point. No animation to let the 
menu disappear. 

The left-most and right-most chapter buttons also have their “Left” or 
“Right” action defined to move to the next chapter menu.  

For the right-most button it moves to an animation menu P1 (or 
P2,P3,P4 or P5) that has only static elements, but which slides the 
chapter images to the left to end with the next set of chapter images 
(the carousel menu – see Force of Execution). Once the animation 
ends, control is handed to the next chapter menu (“Main Scenes 2” or 
further).  

 

Because menu “P1” only has picture objects, it must have an Enter 
animation as well as an action to transfer control. 

 

Clearly the same procedures are used when you move to lower 
chapter numbers: the sliding than occurs to the right to show the 
lower chapter images. 

Because the chapter images must animate but the remainder (arcs at 
the left side) must remain where they are, the chapter images are part 
of animation group 1 while the rest is not part of any group. 

 

Setup 

Setup Pre 
The menu “Setup Pre” that is activated from the main menu, complete 
consists of static objects. It serves the same purpose as “Scenes Pre”: 
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the already shrunk main menu still has parts of its menu choices 
displayed. These button texts (collected in animation group 1) are 
faded away in 4 frames. Then control is handed over to “Main Setup” 
where the [Audio1] button is selected. 

 

Main Setup 
The “Main Setup” menu has buttons to select either Russian, 
Portuguese or Italian audio. For subtitles you can chose between 
Portugues, Italian or none. 

This type of menu is ideal for the use of the “current” state of a button 
to indicate the current audio and subtitle setting. 

The three images used for the three states of each button are shown 
below. The texts are static images, the button states are black circles 
(normal), green background rectangles (selected) and green filled 
circles (current).  

 

Each “On ENTER” action performs a change of the setting of audio or 
subtitle stream. All buttons have a “Left” action that closes the Setup 
menu and returns to the main menu. 

To achieve this, the “Left” action performs an animation, passes 
control to an in-between picture-only menu before returning to the 
main menu. 

 

It slides all objects of group 1 (all elements in the grey arc and the arc 
itself) from their current position to the left over 450 pixels. This will 
hide the menu buttons and most of the text behind the yellow arc 
BG1. 
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The next menu “Main Menu 3” does nothing but fading what is left 
visible of the text (collected in group 1) before passing control to the 
“Main Menu 4”. 

This menu expands the main menu objects to their planned location 
again before passing control to the “Main Menu 1” that has its 
buttons. The expansion means a slide to the right over 266 pixels in 10 
frames of the white arc, the three menu choices and the grey arc. The 
yellow arc remains where it is. The three menu choices “suddenly” 
appear partly. Where in other animations they are faded out, they are 
not faded in here. The “play movie” button is originally at left=45 
pixels (which is its default left=0). The end of the animation puts it at 
left=45+266=311 which is the default position in “Main Menu 1”). 

 

 



Blu Disc Studio Live 99 

Popup Menus 
The popup menus are identical to the normal menus, with the usual 
exception that the real movie plays rather than a menu move. 

All popup menus are faded away when the viewer discards them by 
pressing the “popup” button on the remote-control again. 

 

Rather than moving to the ordinary menus (if “Left”) is pressed, 
control is transferred to the popup menu equivalent of the menu – 
only this way the movie keeps playing instead of being interrupted 
because we move to an ordinary menu. 

 

Movie 

The movie that opens the popup menu has a “popup menu” action as 
well as a “end action” defined for when the movie ends. 

 

When the movie completes, the “Main Menu In1 2” is opened that is 
mostly a clone of “Main Menu In1” (the arcs are slightly smaller). It 
purpose is to slide the yellow arc in sight (animation group 1) as well as 
the rest (animation group 2). 

Main menu 

Main Menu In1 
A clone of the ordinary menu “Main Menu In1”. 

As in the ordinary “Main Menu In1”, both pressing “Right” and “OK” 
result in the popup “Scenes Pre”. 

Setup 

Setup Pre 
All setup menus are also clones of the ordinary menus. 

Chapters 

Scenes Pre 
The chapter scenes menus are slightly different. Where in the ordinary 
menus, the first chapter menu is opened at the first chapter, the 
popup menu opens the chapter menu that has the current chapter as a 
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button. A second menu animation is needed, once on the right menu, 
to select the current chapter. 

Because the menu consists entirely of static objects, it must pass 
control to another menu after the animation. 

 

The animation fades out what is left over of the “play”, “chapters” and 
“setup” button texts first (collected in animation group 1).  

The control is then passed to the right menu through a Switch action. 
For this, it checks the current chapter number and passes control to 
the proper scenes menu. A range can be specified using “first – last” 
condition values. The menu that opens is another animation menu 
with only static objects. 

 

The “Main Scenes 11” popup menu again has a number of objects 
collected in animation groups 1 and 2. The yellow and white arc 
remain stationary. 

• Group 1 has the gray arc and “Chapters” text button-that-
became-picture 

• Group 2 has all the chapter images and numbers 

The menu starts with performing some animation that builds up the 
Chapters menu: the left side arcs and the chapter images. 

 

The group 1 is slid in from the left (over 450 pixels), group 2 slides even 
further in (1594 pixels) to their position specified in their (left,top) 
position properties. 

Now that the proper menu is open, the right chapter image must be 
set as default selected button. We’re in the second stage of animation 
where the right chapter can be set. 

This is done again using a Switch statement, that transfers control to 
the real chapter menu, set to the current chapter. The Switch 
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statements are unique for each chapter menu. Below we show the 
statement for the “Main Scenes 11” popup menu. 

 

At the end of the Switch action, control is passed to “Main Scenes 1” 
menu that has the chapter images as proper buttons that will allow 
movie playback from any chapter. 
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Valerian 
and the city of a thousand planets 
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The final product 
• Movie showing the resulting menu in action: 

https://youtu.be/Mq-zjW18_nw  

• Sources in BDS project folder: n/a 

• Movie instructing how to create the project: n/a 

Story 

A dark force threatens Alpha, a vast metropolis and home to species 
from a thousand planets. Special operatives Valerian and Laureline 
must race to identify the marauding menace and safeguard not just 
Alpha, but the future of the universe. (based on a French comic strip 
on Valerian and Laureline by Pierre Christin and Jean-Claude Mézières, 
known in the Netherlands under its comic strip name “Ravian”) 

137 min, 2017, USA, director: Luc Besson 

Disclaimer 

The Valerian project discussed is an adaptation of the original Valerian 
project once made and on which the YouTube movie is based. BDS has 
since then become more powerful so some of the original constructs 
were no longer needed. Therefore, this is a “refurbished” project. 

Overview 

The movie is a live action adaptation from a well known French comic 
strip.  The extended blu-ray has a lot of extra bonus material. The main 
menu uses an intro movie that shortly announces “Valerian” before 
moving into the regular background menu movie and main menu with 
“Play movie” as the selected choice at the left.  

 

When the movie plays, the popup menu is different from most others. 
Rather than showing a menu on top of the movie, the movie is 
reduced in size to fill the middle part of an otherwise completely filled 
popup menu. 

https://youtu.be/Mq-zjW18_nw
https://www.imdb.com/name/nm0000108/?ref_=tt_ov_dr
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The popup menu bar is just as the regular main menu: the selected 
entry is always at the left side of the bar. Pressing the Up button 
reveals an additional menu with relevant extras (such as bonus movies 
or set up of audio). All popup menus have an AutoClose of 7 seconds – 
except the bookmarks popup menu. This way they won’t stay on 
screen when the viewer makes no choice within those 7 seconds. 

The bonus movies interrupt the main movie, show themselves full 
screen and when done, the pop menu is shown again and the main 
movie continues (resumes) where it was interrupted in the middle of 
the popup menu. 

The original bookmarks popup menu allowa up to 15 bookmarks set in 
the main movie when the Green remote-control button is pressed.  
The “refurbished” one reduces this to 4 bookmarks (just to keep the 
code limited). 

While the movie plays, the same buttons can be used to set a 
bookmark at the playing time position. 

A timeline is shown when the movie plays if you press the Up button. 
It shows the progress of the movie and the bookmarks set. You can 
select any of the bookmarks and either delete it or continue the main 
movie playing from that bookmark onwards. 

Interesting bits 

The main menus and popup menus act as a sliding menu when a 
change of item occurs. There is only one button (the left most one) 
active, all other objects look like buttons but are pictures.  

Sliding from one choice (e.g. “Play Movie”) to the next (“Setup”) or 
previous (“Special Features”) is done by using animations and actions: 
one for a slide left and one for a slide right. Each slide is performed by 
a transition menu without buttons. Using two animation/action pairs 
only half the transition menus are needed as they can perform a slide 
to the left (animation 1) or a slide to the right (animation 2). 

The movies and menus are set to save state, meaning it can be 
resumed or displayed again if they get interrupted by a disc ejection 
and a re-insert at a later time. 
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The scenes or chapters menu is displayed in vertical fashion rather 
than the usual horizontal version. Only three chapters shown per 
menu, the middle one is the “selected” one and is shown larger (by 
zoom in animation). (This resembles King’s Speech turned by 90 
degrees and with added animation). 

The use of the popup menus is entirely different. Rather than a menu 
on top of the movie, the menus take center stage and the movie is 
reduced to fill only a quarter of the screen in the middle of the menu. 
All popup menus except the bookmarks menu have an AutoClose time 
of 7 seconds. 

The “Special Features” also contain a Bookmarks section – one of the 
few using bookmarks to position points of return of the main movie.  

A second type of popup is used while the main movie plays. If you 
press the “Up” button, a timeline with progress bar is shown. It also 
displays any bookmarks already set and, like in the Bookmarks popup, 
you can add bookmarks. To delete a bookmark, you first select it and 
then delete it. This change is immediately reflected on the timeline. 

When a bonus movie is played, the main movie is suspended and 
resumed afterwards (either full screen or in the center of the popup 
menu). The GPR 1 plays a role in this. It has a value that reflects the 
bonus being played and can be considered as a “comeback” indicator 
of what menu to open once the bonus movie finishes. 
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Ordinary menus 

Save State: enable Restore 

The project is set up to ensure the main movie and menus can be 
resumed when they are interrupted by ejecting the disc or playing a 
bonus movie while the main feature played. 

The main movie and all bonus movies have their property “Allow Save 
State” set. 

 

The disc is similarly enabled to restore its state when the disc is 
reinserted into the player at some later stage through the Project > 
Project Settings> General tab in the “JAR signing” section. 

 

The Restore feature does require that the JAR file is signed in the same 
specification tab. 

Loading 

The disc opens with a very short animation by displaying various .png 
images shortly after each  other, revealing the two film leads. This 
controlled by an .anim file specified in the Project> Project Properties> 
Loading tab.  

 

Eleven .png images are shown for the duration of 2 frames (2/24th 
second) as specified in the Loader.anim file. 

 

         

Menu sequence 

When the disc opens, a number of movies and menus are shown, 
depending on what buttons are pressed. The figure below shows the 
navigational order. 
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Intro movie 

The First Play starts with a short movie showing the film title. 

 

Its End Action passes control to “Main Menu Intro”.  

Main menus 

There are five main menus, although you’d think there is only one.  
Each menu has a single button and an animation makes sure the 
button is always in the left most position on the menu bar. All other 
buttons look like buttons but are mere pictures. Clearly they have 
been made as clones of each other where only the active button is 
different. 

The menu bar of all five menus has four potentially selectable items 
and the selected one is always on the far left of the bar. Being the only 
button, it seems there are four main menus, one for each selected 
option.  

All “main menu” menus have a simple small rectangular bar at the 
bottom of the screen – the rest is taken up by the menu movie (the 
same one on all menus in this section, menu or transition menu). This 
menu movie keeps playing seamlessly during the change of menus. 

The 5 menus with one button each are: 
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• Main menu Intro (with “Play movie” button) – identical to 
“Main movie Play” except its opening animation fills the menu 
bar with options. 

• Main menu Play (with “Play movie” button) – (start the feature 
film “Valerian and the city of a 1000 planets”) 

• Main menu Setup (with “Setup” button) – (sets audio and 
subtitle tracks) 

• Main menu Scenes (with “Scenes” button) – (shows the 
chapter menus of the feature film) 

• Main menu Bonuses (with “Special Features” button) – (show 
bonus movies or bookmarks) 

Main Menu Intro 
The Main menu Intro is started as result of the End Action of the First 
Play set “Intro movie” (not to be confused with a menu’s “intro movie” 
property). 

This menu has an active “Play” button and it identical to the Main 
Menu Play It differs from it because this is the first time the main 
menus are shown. All button texts “Setup”, “Scenes” and “Special 
Features” are animated to slide in onto the menu bar one after the 
other until they have reached their menu position. The “Play Movie” 
button simply fades in and is already in position. 

 

 

The intro movie has two chapters: one at the start and one at the end. 
The Play button does not become active before the intro movie has 
completed. 

From here on, the menu acts exactly the same as Main Menu Play. The 
latter will in future always become the active menu with the menu bar 
items already in place. The Main menu Intro is never again reached. 

Main menu Play 
The Main menu Play can do three things: 

• Press the “Play Movie” button and start the feature film 

• Press the Right button and move to the Main menu Setup 

• Press the Left button and move to the Main menu Bonuses 
(that contains the “Special Features” button) 

The Main menu Intro has exactly the same options. But once a choice 
is made, the navigational structure will never revisit the Main menu 
Intro but rather show the Main menu Play instead. 
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Transition menus 
The change from one menu to the next is achieved via animation 
where a transition menu without any button shows a sliding of the 
button pictures and ends when the next main menu and its button can 
be shown. We’ll show the two button-menus and the transition menu 
for the change from Play to Setup. 

 

Main menu play (or Main menu Intro) 

 

Transition menu Play setup (with text “play movie” also at same 
position as “Special Features”) (slides to the left over 1 menu item). It 
has no buttons. 

 

Main menu Setup with active ”Setup” button. 

To enable the transition, different actions are associated with the one 
button on the menu.  
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Depending on whether you press the Left or Right remote-control 
button, the corresponding transition menu is opened simulating a 
transition in the other direction. This transition menu has no buttons 
and therefore its opening “On Enter” action must transfer control to 
another menu (or series of menus as long as the last one has buttons).  

• The “Transition Bonuses Play” menu provides the animations 
from Play to Bonuses ([anm/act 2]) using Left button or from 
Bonuses to Play ([anm/act 1]) using Right button. 

• The “Transition Play Setup” menu has animations from Setup 
to Play ([anm/action 2]) using Left button or Play to Setup 
([anm/action 2]) using the Right button. 

This “trick” is used more often: there is a single transition menu that 
starts from menu B and moves to menu A (going backwards, [anm/act 
2] ) or to menu C (going forwards, [anm/act 1]). The end result (the On 
Enter action 1 or 2 of the transition menu) opens the menu A or C. 

Let’s just look at the “Main Menu Play” (which is our menu B) moving 
into “Main Menu Setup” (remote control button Right) (our menu C) 
The other transitions are similar. The transition menu only contains 
pictures. 

 

 

The animation started by the [anm/act 1] is specified as below. Group 
3 is just the “play 1” object (fades in), group 1 is just the “play” object 
(fades out) and the rest is group 2 (only slides). The SETUP is initially 
positioned at left=771 with width=99 and must end up centered where 
PLAY MOVIE is at left=384 and width=166. The slide to the left 
therefore must be over (771-384)=387 but compensating for the width 
–(166-99)/2 = 8.5 hence 379. 
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When the menu selection goes from “Setup” to “Play” (reverse 
direction), the “Main Menu Setup” has its Setup Button set for the 
“Left” action. This invokes the same “transition menu Play Setup” , but 
uses the second animation pair, [anim/act 2]. 

 

That animation looks after the sliding to the right of all menu items. 

 

position of each text is the same as the position of that text on the real 
button menu that takes control.  

Main menu Setup 
The “main menu Setup” has the same transition features to move to 
its neighbouring menu options. Its “On Enter” or “Press Up” is 
different. They both open a new menu “Settings”. As default button 
either audio “Russian” or “English” is taken – depending on the current 
movie audio track selection. 

Settings menu 

The Settings menu duplicates the “main menu Setup” (the horizontal 
bar) and adds a part on top.  
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What you see is all text images. The buttons have: 

• no “normal” state (the text images say it all) 

•  a “selected” state image with two horizontal stripes at top 

and bottom of a menu item         

• a “current” state is indicated by a blue circle  

     

The assignment of images to and the use of the button states 
(especially the “current” state that sets the blue circles) are standard 
BDS behaviour. 

Scenes menu 

The scenes menu is identical to the “main menu Scenes” but when the 
“OK” or “Press Up” button is used, it displays a “chapter N” menu with 
an additional block with three chapter thumbnails. The “N” is the 
current chapter of the movie. 

The Scenes menu has four actions defined on its button. Two of them 
start an animation to move to the next or previous button. 
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When the Up arrow or the OK button is pushed on the remote-control, 
both trigger the same Switch action:  

• if the main movie was interrupted, show the chapter menu 
that belongs to the current movie (this condition applies when 
the disc was reinserted and the movie was interrupted when 
the disc ejected) 

• if the movie hasn’t started (normal disc insertion first time or 
the previous time it ended normally), show chapter menu for 
chapter 1 

All chapter menus have animations. 

 

Chapter menus and transitions between them 
The chapter menus are shown vertically rather than horizontally as is 
often the case. 

There are 16 chapters and therefore 16 menus.  Because of the 
animation, there are also 15 transition menus with two pairs of 
animation/actions to facilitate moving forwards or backwards in 
chapters. This is similar to the “Kings’ Speech” sliding chapter menu 
changes (but vertically). 
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There are two ways to get to a specific Scenes or chapter menu: 

• direct from the Scenes menu (which opens the right chapter 
menu through its Switch action) 

• from the first shown chapter menu, move to the previous or 
next chapter menu via a transition (sliding) menu 

Both ways impose different requirements on the animation 

Let’s look at one of the chapters in the middle: chapter 12. If the movie 
was previously interrupted while playing chapter 12, the Scenes menu 
will open with that chapter as selected chapter. From there, you can 
movie to chapter menu 11 or 13.  

 

The properties of the “Chapter 12” menu are shown below. 

 

Everything in the menu is a picture: the edges, the arrows and the 
chapter images (W11, W12 and W13). The current chapter 12 is 
represented by picture object W12. 

The current chapter 12 grows from 50% to 100% in one of two 
animations: 
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• when the menu is opened directly from Scenes menu and the 
movie was interrupted at chapter 12 earlier, Animation 1 (a 
complex animation, setting up all elements) is used 

 

• when the menu is opened from other scenes menus (when 
we’re arriving here from chapter 11 or 13), the Animation 2 is 
used. This only scales the middle chapter image. The other 
objects are scaled or faded in or out in the transition menus. 

 

The middle chapter image is a picture also. And it looks like a button 
(with its lines on top and bottom – both picture objects). It is not. 
There is a button (located at 0,0 in the frame) but a button with no 
image: neither normal nor selected. Being the only button, it is always 
the selected one. Its position (here 0,0) is irrelevant.  

• Pressing “OK” on the remote-control will invoke the action of 
the button: play to that chapter.  

• Press up or down arrows and it invokes transition menus to 
move to the previous or next chapter menu. It also rescales 
the center chapter image back to small size. The upscaling of 
the new middle chapter image is done by the opening 
animation of that chapter menu 

• Pressing Left or Right closes the chapter menu and returns to 
the “main menu Scenes”. The associated animations fade out 
the images before closing the chapter menu 
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Bonuses menu 

In visual presentation, the Bonuses menu resembles the Setup menu: 
it is an extension to the “main menu bonus” menu and opens when 
the press Up arrow is pressed on the remote-control, triggering the 
Bonuses button’s “Press Up” action and making the top menu item the 
default selected choice.  

 

It retains objects as pictures, but has an additional block of menu 
options. The selected state of a button is represented again by two 
lines in between which the selected choice is sandwiched. 

 

The buttons have actions for: 

• Left – close the menu (animate fade out of options before 
disappearing) and return to the “main menu bonuses” 

• Up/Down to the next menu object 
o on the last object, the Down button remove the popup 

menu and reopen the “Main menu Bonuses” 



118 Blu Disc Studio Live 

o on the first object, the Up button moves to the 
“Bookmarks” object 

• Right – on “Bookmarks” button: open menu “Bookmarks”. This 
slides in from the right into the same rectangle as the 
“Bonuses” items that slide out to left. (When “Bookmarks” is 
closed, it slides out to the right and the “bonuses” come back 
from the left. 

 
 

• Right – on “Creating” (top entry) button:  open menu “Creating 
univers”. This slides in from the right into the same rectangle 
as the “Bonuses” items that slide out to left. (When “Creating 
univers” is closed, it slides out to the right and the “bonuses” 
come back from the left. 

 

 
• Right – on other menu choices: nothing 

• OK – for the menu items attached to movies, the particular 
bonus movie is shown full screen. But not before, via a multi-
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action, the GPR 1 register is set to a value each time a movie is 
played. Its value is set to 

o 1 (Apha and Beyond)– on “Creating Univers” menu,  
o 2 (It takes 2) – on “Creating Univers” menu,  
o 3 (Denizens) – on “Creating Univers” menu, 
o 4 (Motion Capture),  
o 5 (Kris Wu Set) or  
o 6 (Kris Wu 4D scan) 
o 7 (Art of Valerian) – on “Creating Univers” menu  

 
(Oddly enough the register is never reset when the menu 
closes or opens – it retains its last set value. This has no side-
effect here as every time a bonus movie plays from main menu 
or popup, a GPR 1 value is set – a wrong one in case of the 
popup menu).  
 
The End Action of the bonus movie selected and shown, 
performs either: 

• If GPR 1 is set to the number the bonus movie set (see 
above), return to the main menu “Bonuses” (which 
has the menu movie playing in the background) 

 
• If GPR 1 is not set or has the wrong value (happens 

always when a movie was started from the popup 
menu), resume playing main movie at half size and 
display the pop up menu of “Bonuses” (more on this in 
the popup section). 
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Popup menus 
The popup menus are similar to the main menus. Most of them can be 
cloned from the “menus” section of the Project View. Sometimes no 
further work is needed (e.g. all scenes menus are identical in menu or 
popup menu), sometimes small changes must be made because a 
popup menu shows while a movie runs. A main menu has no movie 
running (other than its own menu movie). 

All main popup menus have the same menu bar as the main menus, 
except “Play movie” is replaced by “Main Menu”. The buttons open 
the same Setup, Scenes or Bonuses menus as the main menu 
counterparts. But those menus too are cloned into the popup Project 
Tree section. 

Where the main movie is only partly covering up its menu movie, the 
popup menu in Valerian is special because it uses the entire screen and 
leaves only a hole in the middle in which a movie can play at half size 
(half width and half height, really ¼ of the screen).  

 

 

Special Features (Bonus movies) 

A popup menu opens when the “Popup” button on the remote control 
is pressed.  In some cases you can select in a (Bonuses) popup menu 
what bonus movie to play. When it finishes, you want to reopen the 
popup menu again so another bonus movie can be selected (or the 
menu closed). This requires that the popup menu must show again and 
that the feature film resumes playing in its “hole” in the popup menu. 

A bonus movie can also be started from a main menu while no feature 
movie was playing. In that case, you want to return to the main menu 
Bonuses.  

The End Action of the bonus movie must therefore make the right 
decision: open the main Bonuses menu or the regular menu Bonuses. 
Here comes the register GPR 1 to the rescue. At the start of playing a 
bonus movie, it is given a specific value. The End Action checks this 
value and “knows” whether to reopen the Bonuses popup or regular 
menu. 
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All bonus movies in this project only have 2 chapters: at the start and 
end of the movie.  Therefore, if the user presses “next chapter” on the 
remote control, the movie ends and goes straight to the End Action of 
the movie. Which always performs a check: 

• If GPR 1 has a value between 1 and 7, it was set when the 
bonus played from the main menu, so that menu is reopened 
(as we discussed in the Bonuses menu) 

• If GPR 1 has any value outside the 1-7 range, it was set while 
the popup menu was open, so the popup menu is reopened 
and the main movie is resumed from the point where it was 
interrupted by the bonus movie. 

From pixel conservation point of view the popup menu background 
(object PG)  is not very efficient – the entire screen of 1920 x 1080 
pixels is counted despite the hole in the middle. This amount is 
considered used against a maximum total of 7 900 000 pixels allowed. 
Because the other menus are not that big, the entire project still is 
within allowable limits.  

 

The position and size of the (here blue coloured) hole must be 
determined as you must specify the area in which the rescaled feature 
film can run.  

When you’ve used Photoshop to create the popup menu (or some 
other image editor) you may already have precisely positioned the 
hole where you want it and noted down its position in that tool. 

In BDS Designer View you can do this by positioning the cursor pointer 
at each of the corners of the “hole” and read the (Top,Left) 
combination from the screen.  
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Alternatively, you can create a temporary rectangle object that you 
massage to precisely fills the hole and write down the position of its 
left top corner and its width and height. 

From this data you can determine the position of the top left corner 
and the width/height. The width at ½ HD size should be ½ x 1920 = 960 
and height ½ x 1080 = 540 when you “cut” the hole the right size. 

Whatever method you use, our popup menu hole has coordinates: 

Top: 158 
Left: 749 
Width: 960  (=1/2 x 1920) 
Height: 540 (=1/2 x 1080) 

That means that the movie has to be scaled to ½ HD (1/2 the lengths of 
the HD sides – ¼ of the screen area) and positioned at (749,158). 

When the main movie plays full screen and its “popup menu” button is 
pressed, it opens the “Menu Play popup” menu and the opening code 
of the menu forces the movie to rescale and continue playing but at ½ 
scale inside the menu hole. This is achieved by a multi-action specified 
for the main movie. 

 

When eventually the popup menu closes, the movie automatically 
rescales to full screen. 

Once the popup “Menu Play popup” is opened, the usual press Left / 
Right buttons allow you to move along the menu bar options the same 
way as the Main Menu Play counterpart (of which it is cloned).  

A press Up button subsequently opens the menu with choices (either 
Munu Setup popup, Menu Scenes popup or Menu Bonuses popup) – 
another clone from the regular menus. 

The main movie independently keeps running in the hole. If a new 
bonus movie is started from the “Bonuses popup” menu it is 
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interrupted (state saved), the bonus move takes over full screen, but 
will at the end return to the “Bonuses popup” menu and resume the 
main movie in its hole. 

 

 

When the Scenes option is selected, the “Scenes popup” menu opens. 
Given the fact the movie is running, the same Switch statement is used 
to select the current movie chapter and display that one initially in its 
scenes menu. All “Chapter” and “Transition X to Y” menus are clones 
of the regular menus. 

When a chapter is selected, the Scenes popup menu is closed. The 
main movie takes full screen again automatically. 

Return to the popup menu 
While the Bonuses popup menu is open, the main movie continues in 
the small rectangle in the middle. Two of them open a new menu that 
slides over the bonuses one and provides other menu options. These 
are  “Creating Univers” and “Bookmarks”. They open their respective 
popup menus “Creating Univers” and “Bookmarks”. Which are almost 
clones of their main menu counterparts. 

If a bonus movie is selected, a multi-action is executed that is similar to 
the multi-action on the Bonuses main menu except for values assigned 
to the GPR 1: 

• Set GPR 1 to a value specific for the bonus: 
o 101 (Alpha and Beyond) – on Creating Univers popup, 
o 102 (Takes Two) – on Creating Univers popup, 
o 103 (Denizens) – on Creating Univers popup, 
o 104 (Motion Capture Cameras) 
o 105 (Kris Wu Set Tour) 
o 106 (Kris Wu 4D scan) 
o 107 (Valerian Art) – on Creating Univers popup 

• Close the “Bonuses” popup  

• Run the selected movie from the start in full screen. It can be 
prematurely ended when the “popup” button of the movie is 
pressed. This performs a [next chapter] action. There are only 
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2 chapters, so essentially the movie ends, triggering the End 
Action. 

At the end of the bonus movie, its End Action executes. Although it 
runs a script that checks the value of GPR 1, it always checks for values 
passed in a main menu (with background menu movie) which is an 
integer value 1 to 7, never the values set when the movies start from a 
popup Bonuses menu, values 101 to 107. Therefore, the end of a 
movie always results in  

• Restore main movie at point of suspension 

• Reopen popup menu “Bonuses” 

• Rescale main movie to ½ size and play in the popup hole in the 
middle. 

For the Kris Wu Set Tour the End Action script look like the code 
below. Only the last part (if) is executed from a popup “Bonuses” 
ending bonus movie. The scripts for the other movies are similar. 

 

You can simplify this by making it into a UDF_reopenPopup (String 
menuName; buttonName) with changes that make menu names and 
button names parameters to provide when the function is called. For 
example: 

      manager.activateSegment( 
         "S:PM_" + menuName + "_popup.show_menu.main"); 

rather than duplicating the script code with minor changes. Then the 
End Action becomes a simple call to the UDF function with values 
given for the two parameters. 

Timeline and Bookmarks 

This project is one of the few showing a timeline and using bookmarks. 
Bookmarks are user-specified positions in a movie and, given the right 
menus, the viewer can select any of the bookmarks set and jump to it 
to start movie playback from that position forward. 

Timeline 
The Timeline is shown while the movie plays and the Up button is 
pressed on the remote-control. It shows the length of the movie and 
the fraction that has already been played by a grey progress bar that 
slowly lengthens from 0% at the start to 100% at completion of the 
movie. 
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It also shows any defined bookmarks as small green indicators on the 
timeline. In fact, most of the timeline and the bookmarks are copied 
from the “Timeline BookmarksBR” project of the BDS User’s Guide by 
simply merging that project into this one. That means that adding, 
deleting and showing bookmarks is all done through User Defined 
Functions (in Project > Project Settings > Advanced tab). I revert to that 
Guide for details rather than duplicating it here. 

At the left, the current bookmark time is shown (little green indicator 
 on top of one of the green bookmark bars). 

 

The current bookmark can be deleted when the Red button is pressed. 

Using the left ( ) button, right ( ) button you can navigate to the 
previous or next bookmark.  

 

Pressing OK ( ) resumes playback of the movie at that bookmark 
timing. 

A small change was needed compared to the User’s Guide solution. 
When an informative message “Bookmark Added” was displayed, the 
“Timeline BookmarksBR” project either continued the movie playing or 
reopened the timeline menu.  

In this project however, bookmarks can be added and deleted when 
the timeline is shown, but also when the popup Bookmarks menu is 
shown. To distinguish what menu to reopen when the informative 
message closes, the UDF function “CloseMessageMenu” uses the GPR 
5 value to remember what menu to reopen: 

• 1 – the movie ran while a bookmark was added 

• 2 – the Bookmarks popup menu was open when a bookmark 
was added or deleted 

• 3 – the Timeline popup menu was open when a bookmark was 
added or deleted 

By checking on that value, the right menu reopens. 
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Of course the popup menu that resulted in the addition or removal of 
a bookmark must set the GPR 5 value correctly. For example, the 
“Green” button (Add a bookmark) and “Red” button (Delete 
bookmark) in the Bookmarks popup menu contains the following 
action: 

 

And the value “2” indicating the Bookmarks popup as originator, is 
handled in the UDF script with the BDS function 
manager.setGPR(number,value).  

For the Green button (UDF_AddBookmark) this looks like the following 
(showing either “Bookmark Added” or “Too Many Bookmarks” if you 
already got 4): 

 

Bookmarks popup menu 
To use bookmarks from the “Special Features” (Bonuses) menu, you 
must select its bookmarks option, press OK or the “Right” button. That 
opens the “Bookmarks popup” menu. 
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All bookmark timings are shown in the list at the left: one timing and 
up/down arrows for the timing of the previous or next bookmark. 

The same Red and Green button are active. They call the same UDF 
functions as when those buttons are pressed when the Timeline menu 
is shown. The response of the system is the same. Just the value stored 
in GPR 5 is a “2” for the Bookmarks popup instead of the “3” for the 
Timeline popup. 

Animation of the Bookmarks popup menu 
The Bookmarks popup menu appears from the Special Features 
(“Bonuses”) popup menu option. The “Bookmarks” popup option 
makes the “Bonuses” block slide away to the left and make room for 
the “bookmarks” block that indicates the timing of one bookmark with 
up/down arrows to show earlier or later bookmarks.  
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This happens by defining an animation/action for the “Press Right” (as 
well as the “On ENTER”) action of the “Bonuses” bookmark button 
whose “selected” state is given by two horizontal lines. 

 

 

The bookmarks popup slides in from the right and shows itself within 
the clipping area (that “protects” the movie hole). The second part of 
the menu, the block indicating the remote-control buttons to add or 
delete bookmarks, simply appears. 

 

 

The “Bookmarks” menu has three buttons, “Up”, “Down” and 
“Button”. None of them have any visible indication. “Up” and “Down” 
are positioned at (0,0) in the top left hand corner of the screen with no 
width or height.  
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Their only action is “On Enter” which moves to the “Button” button. 
The animation is to move the next bookmark time (only member of 
animation group 4) upwards from the bottom to the middle (“Up”) or 
downwards from the top to the middle (“Down”). 

Up:   

Down:  

The “Button” button is positioned at the same location as the text 
“Bookmark Time” (that shows text “EMPTY” or timing value – set by 
menu opening code). 

The menu opening code is relatively straight forward: 

 

 

It starts by checking the number of bookmarks defined for the “Movie” 
feature film. When zero, the menu text field that holds the timing of 
the current bookmark says “EMPTY”. If there are bookmarks, the first 
one is shown, and the menu text fields holds the text “BOOKMARK “ 
plus the timing in hh:mm:ss format. 

If the viewer presses the “Up” button the “Button” buttons action for 
it is to display the previous bookmark, if available. If “OK” is pressed, 
the movie is resumed at that bookmark. 

 

The [script] hidden behind the Up button is short: the code determines 
if there are bookmarks. If we’re already on the first bookmark or there 
are none, nothing happens. If we’re on bookmark 2 or higher, the 
previous one is made current and the menu text fields are adjusted. 
This involves renewing the Bookmarks popup menu. This time by 
opening it using animation 3 (which simulates a sliding down). 
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For the Down button a similar situation is defined by showing the 
popup menu “Bookmarks” through its animation 4. 

The [animation 4] of the Bookmarks popup menu is defined as 

 

The animation 4 moves the currently displayed timing upwards and let 
it fade out. 

 

The action 4 script is similar to the action 3 script. If there are any 
bookmarks, the next one is made current. If we’re on the last 
bookmark already, the “nextBookmark” function leaves the bookmark 
alone. The bookmark timing field in the Bookmark popup menu is 
adjusted to the new timing value in hh:mm:ss format. 
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Further improvements 

If you get a bit familiar with Javascript, you might change the values of 
“1”, “2” or “3” (to indicate whether a red or green button was pressed 
while a movie, the Bookmarks popup or the timeline popup was 
visible) into User Defined Variables (UDV) and use their names rather 
than values in all the UDF function code. It makes it a bit more 
maintainable if ever you change these values. 

Also code currently stored in End Action actions of movies might be 
made more generic storing them as UDF functions, as indicated earlier 
in the text. 

Various actions that can still be defined using “point and click” BDS 
menu options, might be converted into Javascript too so the entire 
project is Javascript driven. Switch statements can become if…else… 
constructs and Multi-action simply becomes a sequence of BDS 
functions. 


